# Revision History

The following table shows the revision history for this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/30/2016</td>
<td>2016.4</td>
<td>2016.4 <em>What's New</em> Featuring the latest:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Device Support</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Board Support</em>.</td>
</tr>
<tr>
<td>10/05/2016</td>
<td>2016.3</td>
<td>2016.3 <em>What’s New</em> Featuring the latest:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Device Support</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Vivado Design Edition Tools</em>.</td>
</tr>
<tr>
<td>06/08/2016</td>
<td>2016.2</td>
<td>2016.2 <em>What’s New</em> Featuring the latest:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Device Support</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Vivado Design Edition Tools</em>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New <em>Simulation</em> section.</td>
</tr>
<tr>
<td>04/13/2016</td>
<td>2016.1</td>
<td>Editorial updates and added new devices to the General Access section.</td>
</tr>
<tr>
<td>04/06/2016</td>
<td>2016.1</td>
<td>Initial version.</td>
</tr>
</tbody>
</table>
# Table of Contents

Revision History ................................................................. 2

## Chapter 1: Release Notes 2016.4

What’s New ................................................................................. 5
Important Information ................................................................. 6
Known Issues ................................................................................. 7

## Chapter 2: Architecture Support and Requirements

Operating Systems ........................................................................ 8
Architectures ................................................................................ 9
Compatible Third-Party Tools .......................................................... 9
System Requirements ....................................................................... 11

## Chapter 3: Download and Installation

Downloading the Vivado Design Suite Tools ........................................ 13
Installing the Vivado Design Suite Tools ............................................. 14
Installing Cable Drivers ................................................................... 18
Adding Additional Tools and Devices ................................................ 19
Network Installations ....................................................................... 20
Batch Mode Installation Flow ............................................................ 22
Obtaining Quarterly Releases ............................................................. 25
Uninstalling the Vivado Design Suite Tool ........................................... 26

## Chapter 4: WebTalk

WebTalk Participation .................................................................... 28
Setting WebTalk Install Preference ................................................... 29
Setting WebTalk User Preferences .................................................... 30
Checking WebTalk Install and User Preferences .................................. 31
Types of Data Collected .................................................................. 31
Transmission of Data ....................................................................... 32

## Chapter 5: Obtaining and Managing a License

Licensing Overview ....................................................................... 33
Generating/Installing/Managing Activation-Based Licenses ........................................... 36
Generating/Installing Certificate-Based Licenses ......................................................... 50
Managing Licenses On Your Machine .......................................................... 56
Using the Xilinx Product Licensing Site ............................................................. 60

Chapter 6: Older Release Notes

Release Notes 2016.3 .................................................................................. 75
Release Notes 2016.2 ............................................................................... 84
Release Notes 2016.1 ............................................................................... 86

Appendix A: Additional Resources and Legal Notices

Xilinx Resources ...................................................................................... 101
Solution Centers ...................................................................................... 101
Documentation Navigator and Design Hubs .............................................. 101
Licenses and End User License Agreements .............................................. 102
References ............................................................................................... 102
Training Resources ................................................................................... 103
Please Read: Important Legal Notices ...................................................... 103
Release Notes 2016.4

What’s New

Vivado® Design Suite 2016.4 introduces the following Device Support and Vivado System Edition Products.

Device Support

The following UltraScale+ devices are introduced in this release.

• Virtex UltraScale+:
  - XCVU11P and XCVU13P

Board Support

Board support enables the use of automation to quickly configure and locate interfaces on the evaluation board. This allows quick development of connectivity platforms when used with Block and Connectivity automation. The following board support packages are introduced in this release.

• Zynq UltraScale+ MPSoc – ZCU102-ES2 with support for the following interface.
  - Processing System with support for:
    - USB 3.0
    - Gigabit Ethernet
    - DisplayPort
    - SATA
    - DDR4 (4 GB)
    - QSPI
    - SD card slot
    - Can bus
    - Dual I2C and UARTs
Chapter 1: Release Notes 2016.4

- DDR4 (512 MB)
- GPIO, Dual I2C, & UART

**Virtex UltraScale+** - VCU1180-ES1 with support for the following interfaces
  - PCI Express (Gen4 x8)
  - Dual DDR4 (4 GB each)
  - GPIO, I2C, & UART

**Multimedia IP**
  - Video Test Pattern Generator
    - 8K resolution support and 8 pixels per clock option
    - DisplayPort related test patterns
    - Build time configurability allowing what test patterns to include
  - Video Mixer

**Xilinx Software Development Kit**
  - For release notes information on the Xilinx Software Development Kit (SDK) see Answer Record 66230

---

**Important Information**

**Device Support**

**IMPORTANT:** When opening a checkpoint targeting UltraScale+ Production Evaluation parts, Vivado will issue the following warning:

*Production Evaluation speedfiles are provided in advance of production release and are intended to closely approximate production level performance. Once production speedfiles become available, the design will need to be rerun with the production speedfiles.*

**Simulation**

*Export Simulation (export_simulation)*

Multiple switches have been deprecated in this release.
Table 1-1: Deprecated Switches

<table>
<thead>
<tr>
<th>Switch Name</th>
<th>Default Behavior</th>
<th>User Action</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>-ip_netlist</td>
<td>False</td>
<td>None</td>
<td>Fastest simulation is available only in pure RTL. Export simulation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>optimized to write scripts for fastest simulation performance.</td>
</tr>
<tr>
<td>-language</td>
<td>Mixed</td>
<td>Mixed language simulator</td>
<td>In order to ensure the fastest simulation performance, export simulation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>required</td>
<td>will only use the language of the IP RTL</td>
</tr>
<tr>
<td>-single_step</td>
<td>• True for Cadence IES • False for others</td>
<td>Be aware of this change</td>
<td>Cadence IES simulation will deliver irun scripts that can handle mixed language RTL simulation. Using single-step for the other simulators requires gate level simulation netlist.</td>
</tr>
</tbody>
</table>

Integrated Simulation (launch_simulation)

- Starting in Vivado 2016.1, the Generate Scripts Only capability has been deprecated and removed from the IDE.
- User should use the Export Simulation capability instead. This provides the functionality for exporting files from Vivado (IP and IP Integrator) to use in external verification environments.

Vivado Design Suite Documentation Update

In the 2016.4 Vivado Design Suite Documentation release, not all documentation will be available at first customer ship. Use the Update Catalog button in DocNav to stay up-to-date with the 2016.4 documentation suite.

Note: DocNav is a 32-bit application and requires the installation of 32-bit libraries on Linux in order to function.

Known Issues

Vivado® Design Suite Tools Known Issues can be found at Answer Record 66830.
Chapter 2

Architecture Support and Requirements

Operating Systems

Xilinx® only supports the following operating systems on x86 and x86-64 processor architectures.

**Microsoft Windows Support**

- Windows 7 and 7 SP1 Professional (64-bit), English/Japanese.
- Windows 8.1 Professional (64-bit), English/Japanese.
- Windows 10 Professional (64-bit), English/Japanese.
- Vivado® Lab Edition is the only Xilinx toolset that supports Windows 7 SP1 Professional, 32-bit Operating System. Lab Edition also supports the 64-bit systems.

**Linux Support**

- Red Hat Enterprise Workstation/Server 7.1 and 7.2 (64-bit)
- Red Hat Enterprise Workstation 6.7 and 6.8 (64-bit)
- Red Hat Enterprise Workstation 5.11 (64-bit)
- SUSE Linux Enterprise 11.4 and 12.1 (64-bit)
- Cent OS 6.8 (64-bit)
- Ubuntu Linux 16.04 LTS (64-bit)
- Vivado Lab Edition is the only Xilinx toolset that supports the Red Hat Enterprise Workstation 6.6 and 6.7, 32-bit Operating Systems. Lab Edition also supports the 64-bit systems.
Chapter 2: Architecture Support and Requirements

Architectures

The following table lists architecture support for commercial products in the Vivado Design Suite WebPACK™ tool versus all other Vivado Design Suite editions. For non-commercial support:

- All Xilinx Automotive devices are supported in the Vivado Design Suite WebPACK tool.
- Xilinx Defense-Grade FPGA devices are supported where their equivalent commercial part sizes are supported.

Table 2-1: Architecture Support

<table>
<thead>
<tr>
<th>Device</th>
<th>Vivado WebPACK Tool</th>
<th>Vivado Design Suite (All Other Editions)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zynq® Device</td>
<td>Zynq-7000 AP SoC Device</td>
<td>Zynq-7000 AP Soc Device</td>
</tr>
<tr>
<td></td>
<td>• XC7Z010, XC7Z015, XC7Z020,</td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>• XC7Z030, XC7Z007S, XC7Z012S, and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• XC7Z014S</td>
<td></td>
</tr>
<tr>
<td>Virtex® FPGA</td>
<td>Virtex-7 FPGA</td>
<td>Virtex-7 FPGA</td>
</tr>
<tr>
<td></td>
<td>• None</td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>Virtex UltraScale™ FPGA</td>
<td>Virtex UltraScale FPGA</td>
</tr>
<tr>
<td></td>
<td>• None</td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>Virtex UltraScale</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• None</td>
<td></td>
</tr>
<tr>
<td>Kintex® FPGA</td>
<td>Kintex-7 FPGA</td>
<td>Kintex-7 FPGA</td>
</tr>
<tr>
<td></td>
<td>• XC7K70T, XC7K160T</td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>Kintex UltraScale™ FPGA</td>
<td>Kintex UltraScale FPGA</td>
</tr>
<tr>
<td></td>
<td>• XCKU025, XCKU035</td>
<td>• All</td>
</tr>
<tr>
<td>Artix® FPGA</td>
<td>Artix-7 FPGA</td>
<td>Artix-7 FPGA</td>
</tr>
<tr>
<td></td>
<td>• XC7A15T, XC7A35T, XC7A50T,</td>
<td>• All</td>
</tr>
<tr>
<td></td>
<td>• XC7A75T, XC7A100T, XC7A200T</td>
<td></td>
</tr>
</tbody>
</table>

Compatible Third-Party Tools

Table 2-2: Compatible Third-Party Tools

<table>
<thead>
<tr>
<th>Third-Party Tool</th>
<th>Red Hat Linux</th>
<th>Red Hat Linux-64</th>
<th>SUSE Linux</th>
<th>Windows-7/10 32-bit</th>
<th>Windows-7/10 64-bit</th>
<th>Ubuntu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mentor Graphic ModelSim SE/DE/PE (10.5c)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Table 2-2: Compatible Third-Party Tools

<table>
<thead>
<tr>
<th>Third-Party Tool</th>
<th>Red Hat Linux</th>
<th>Red Hat Linux-64</th>
<th>SUSE Linux</th>
<th>Windows-7/10 32-bit</th>
<th>Windows-7/10 64-bit</th>
<th>Ubuntu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mentor Graphics Questa Advanced Simulator (10.5c)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Cadence Incisive Enterprise Simulator (IES) (15.20.005)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Synopsys VCS and VCS MX (L-2016.06)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>The MathWorks MATLAB® and Simulink® with Fixed-Point Toolbox (2016a and 2016b)</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Aldec Active-HDL (10.3)</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Aldec Riviera-PRO (2016.06)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Synthesis**

<table>
<thead>
<tr>
<th>Third-Party Tool</th>
<th>Red Hat Linux</th>
<th>Red Hat Linux-64</th>
<th>SUSE Linux</th>
<th>Windows-7/10 32-bit</th>
<th>Windows-7/10 64-bit</th>
<th>Ubuntu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synopsys Synplify/Synplify Pro (L-2016.03)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Mentor Graphics Precision RTL/Plus (2015.2)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Equivalence Checking**

<table>
<thead>
<tr>
<th>Third-Party Tool</th>
<th>Red Hat Linux</th>
<th>Red Hat Linux-64</th>
<th>SUSE Linux</th>
<th>Windows-7/10 32-bit</th>
<th>Windows-7/10 64-bit</th>
<th>Ubuntu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadence Encounter Conformal (9.1)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>OneSpin 360 (2015_12)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

a. Support for Aldec simulators is offered by Aldec.

b. Most Vivado IPs can only be synthesized by Vivado synthesis, because the RTL source can include encrypted files. To use these IPs in a third party synthesis flow, the synthesized netlist can be exported from the Vivado tool in a suitable format for use in the third-party synthesis project.

c. Contact Synopsys for availability of Synplify Overlay or Service Pack.

d. Cadence Encounter Conformal Support is for RTL2Gate using Synopsys Synplify only.

System Generator support is restricted to operating systems that are compatible with The MathWorks MATLAB and Simulink tools.
Chapter 2: Architecture Support and Requirements

System Requirements

This section provides information on system memory requirements, cable installation, and other requirements and recommendations.

The lab exercises require the installation of MATLAB 2014a (or later) and Vivado Design Suite 2014.2 (or later).

System Memory Recommendations

For memory recommendations for the Vivado Design Suite tools, see: https://www.xilinx.com/design-tools/vivado/memory.htm.

Operating Systems and Available Memory

The Microsoft Windows and Linux operating system (OS) architectures have limitations on the maximum memory available to a Xilinx program. Users targeting the largest devices and most complex designs might encounter this limitation. The Vivado Design Suite has optimized memory and enabled support for applications to increase RAM memory available to Xilinx tools.

Linux

For 32-bit Red Hat Enterprise Linux systems, the operating system can use the hugemem kernel to allocate 4 GB to each process. More information can be found on the Red Hat support site at http://www.redhat.com/docs/manuals/enterprise/.

Cable Installation Requirements

Platform Cable USB II is a high-performance cable that enables Xilinx design tools to program and configure target hardware.

Note: The Xilinx Parallel Cable IV is no longer supported for debugging or programming.

Recommended: To install Platform Cable USB II, a system must have at least a USB 1.1 port. For maximum performance, Xilinx recommends using Platform Cable USB II with a USB 2.0 port.
The cable is officially supported on the 32-bit and 64-bit versions of the following operating systems: Windows-7, Red Hat Linux Enterprise, and SUSE Linux Enterprise 12. Additional platform specific notes are as follows:

- Root privileges are required.
- SUSE Linux Enterprise 11: The fxload software package is required to ensure correct Platform Cable USB II operation. The fxload package is not automatically installed on SUSE Linux Enterprise 11 distributions, and must be installed by the user or System Administrator.

For additional information regarding Xilinx cables, refer to the following documents:

- USB Cable Installation Guide (UG344) [Ref 13]
- Platform Cable USB II Data Sheet (DS593) [Ref 14]

**Equipment and Permissions**

The following table lists related equipment, permissions, and network connections.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory permissions</td>
<td>Write permissions must exist for all directories containing design files to be edited.</td>
</tr>
<tr>
<td>Monitor</td>
<td>16-bit color VGA with a minimum recommended resolution of 1024 by 768 pixels.</td>
</tr>
<tr>
<td>Drive</td>
<td>You must have a DVD-ROM for Vivado Design Suite (if you have received a DVD, rather than downloading from the web).</td>
</tr>
</tbody>
</table>
| Ports              | To program devices, you must have an available parallel or USB port appropriate for your Xilinx programming cable. Specifications for ports are listed in the documentation for your cable.  

**Note:** Installation of the cable driver software requires Windows-10. If you are not using one of these operating systems, the cables might not work properly.

**Network Time Synchronization**

When design files are located on a network machine, other than the machine with the installed software, the clock settings of both machines must be set the same. These times must be synchronized on a regular basis for continued proper functioning of the software.
Chapter 3

Download and Installation

This guide explains how to download and install the Vivado® Design Suite tools, which includes the Vivado Integrated Design Environment (IDE), High Level Synthesis tool, and System Generator for DSP.

Downloading the Vivado Design Suite Tools

Xilinx® Design Tools users have multiple choices for download and installation.

Xilinx introduced Vivado Lab Edition, which features a dedicated and streamlined environment for programming and debugging devices in lab settings.

**TIP:** No license is required to use Vivado Lab Edition tools.

For users wishing to install one of the full Vivado Editions, there are three choices.

Vivado Design Suite - HLx Editions:

- **WebPack and Editions:** Web installer for windows
- **WebPack and Editions:** Web installer for Linux
- **All OS Single File Download**

All Editions and download options are available on the Xilinx website: https://www.xilinx.com/support/download/index.htm

Most files in the Xilinx Download Center are downloaded using the Akamai download manager. For the optimum download experience:

- Allow pop-ups from entitlenow.com.
- Set security settings to allow for secure and non-secure items to be displayed on the same page.
- Allow the Akamai download manager to run Java processes.

To download a full Edition of the Vivado Design Suite:

1. Select the **Vivado Design Tools** tab in the web page.
2. Under the Version heading, click the version of the tools you want to download.
3. Click the link for the installer you want to download.

To download the Vivado Lab Edition tools, go to the Vivado Design Tools tab, select a version of 2015.1 or newer, and download the file associated with the Vivado Lab Edition.

*Note:* Lab Edition installer can be run on both 32 or 64-bit machines. The Full Edition installers work only on 64-bit machines.

---

## Installing the Vivado Design Suite Tools

This section explains the installation process for all platforms for the Vivado Design Suite.

### Installation Preparation

**IMPORTANT:** Before starting installation the following steps must be completed:

- Check the links in Important Information section in Chapter 1 for any installation issues pertaining to your system or configuration.
- Make sure your system meets the requirements described in Chapter 2, Architecture Support and Requirements.
- Disable anti-virus software to reduce installation time.
- Close all open programs before you begin installation.
- The Vivado Design Suite installer does not set global environment variables, such as XILINX, on Windows.

### Lab Edition, Full Product Download, or DVD

If you downloaded the Lab Edition or full product installation, decompress the file and run xsetup (for Linux) or xsetup.exe (for Windows) to launch the installation. If you received a DVD, which only contains the full Edition products, launch xsetup.exe directly.

**RECOMMENDED:** Xilinx recommends the use of 7-zip or WinZip (v.15.0 or newer) to decompress the downloaded tar.gz file.

### Lightweight Installer Download

If you downloaded the lightweight installer, launch the downloaded file. You are prompted to log in and use your regular Xilinx login credentials to continue with the installation process.
After entering your login credentials, you can select between a traditional web-based installation or a full install image download.

- The **Download and Install Now** choice allows you to select specific tools and device families on following screens, downloads only the files required to install those selections, and then installs them for you.

- The **Download Full Image** requires you to select a download destination and to choose whether you want a Windows only, Linux only, or an install that supports both operating systems. There are no further options to choose with the **Download Full Image** selection, and installation needs to be done separately by running the `xsetup` application from the download directory.

**Note:** Lab Edition is not supported through a lightweight installer. You may download the single-file download image for Lab Edition.

![Select Install Type](image)

*Figure 3-1: Vivado Design Suite Installation - Select Installation Source*
Connectivity

The installer connects to the internet through the system proxy settings in Windows. These settings can be found under Control Panel > Network and Internet > Internet Options. For Linux users, the installer uses Firefox browser proxy settings (when explicitly set) to determine connectivity.

If there are connectivity issues, verify the following:

1. If you are using alternate proxy settings to the ones referred to, select the Manual Proxy Configuration option to specify the settings.

2. Check if your company firewall requires a proxy authentication with a username and password. If so, select the Manual Proxy Configuration option in the dialog box above.

3. For Linux users, if either the Use System settings or the Auto detect settings option is selected in the Firefox browser, you must manually set the proxy in installer.
License Agreements

Carefully read the license agreements before continuing with the installation. If you do not agree to the terms and conditions, cancel the installation and contact Xilinx.

Edition Selection

Select the edition or standalone tool that is required. You can also install the Xilinx Software Development Kit (XSDK) as part of the Vivado WebPACK, System and Design editions.

Vivado WebPACK and Design edition users will also be able to upgrade to a higher edition post installation. See Adding Additional Tools and Devices, page 19 for more details.

Tools, Devices, and Options

Customize the installation by choosing the design tools, device families and installation options. Selecting only what you need helps to minimize the time taken to download and
In Chapter 3: Download and Installation, you are instructed to install the product. You will be able to add to this installation later by clicking **Add Design Tools or Devices** from either the operating system Start Menu or the **Vivado > Help** menu.

### Shortcuts and File Associations

You can customize the creation of the program group entries (Start Menu) and the creation of desktop shortcuts. Optionally, you can also create file associations to launch Vivado project files directly with this version of Vivado. The shortcut creation and file association options can be applied to the current user or all users.

### Installing Cable Drivers

On Windows, **Install Cable Drivers** is an optional selection in the installer.
For Linux, because root or sudo access is required to install drivers, this option has been removed from the Linux installer beginning in Vivado 2015.4. The general Vivado installer can now be run on Linux without root or sudo privileges. To install cable drivers on Linux, there is now a script that must be run as root or sudo post installation.

**Script Location:** `<Vivado Install Dir>/data/xicom/cable_drivers/lin64/install_script/install_drivers/`

**Script Name:** `install_drivers`

---

### Adding Additional Tools and Devices

You can incrementally add additional tools, devices or even upgrade Vivado editions post-install. This is useful for users that have chosen to install a subset of devices and/or tools.

To add new tools or devices:

- **Start Menu > Xilinx Design Tools > Vivado <version> > Add Design Tools or Devices.**
- **Launch Vivado > Help > Add Design Tools or Devices.**

If you have installed the Vivado WebPACK or Design Edition, you are presented with the option to upgrade the edition.
Based on the above selection, you are presented with all available tools and devices that can be added to the current installation.

You can also add tools or devices from the Xilinx Information Center (XIC). See the Obtaining Quarterly Releases section for using this flow.

Network Installations

Installing to a network location provides a way for client machines to access the design tools by pointing to it on the network drive. To run the design tools on the network, the client machines must be set up correctly to ensure the environment variables, registry, and program groups all point to the network. The following sections describe the procedure for network setups.
Chapter 3: Download and Installation

Linux Clients

You must source `settings32.(c)sh` or `settings64.(c)sh` (whichever is appropriate for your operating system) from the area in which the design tools are installed. This sets up the environment to point to this installed location.

To run the design tools from a remotely installed location, run an X Windows display manager, and include a DISPLAY environment variable. Define `DISPLAY` as the name of your display. `DISPLAY` is typically `unix:0.0`. For example, the following syntax allows you to run the tools on the host named bigben and to display the graphics on the local monitor of the machine called mynode.

```bash
setenv DISPLAY mynode:0.0
xhost = bigben
```

Microsoft Windows Clients

1. Install design tools to a PC network server. Make sure your users know the location of the design tools and have access to the installation directory, and they have Administrator privileges for the following steps.

2. From the local client machine, browse to the following directory:
   ```
   network_install_location\.xinstall\Vivado_<version>
   ```
   and run the program `networkShortcutSetup.exe`.

   Running this program sets up the Windows settings batch files and Program Group or Desktop shortcuts to run the Xilinx tools from the remote location.

3. From the client machine, launch the Vivado Design Suite tools by clicking the Program Group or Desktop shortcuts, or by running the applications on the network drive.

Installing to a Mounted Network Drive

Xilinx design tools are designed to be installed in a directory under ROOT (typically `C:\Xilinx`). The installer normally presents this option when installing to a local driver.

To work around this issue, either specify a UNC path (for example, `\network_loc\Xilinx\`) or define your target installation directory as `\Xilinx` under the network mount point (For example: `N:\Xilinx`).

Windows 7 default security levels do not allow you to select remote mapped drives. To install Xilinx Design Tools on remote mapped drives, you must change your account control settings using the following steps:


2. Click ‘Change User Account Control settings’ and allow the program to make changes.
3. Click and slide the slide-bar down to the second to lowest setting (as seen in the following figure).

4. Click **OK**.

**Figure 3-7: Vivado Design Suite Installation - User Account Control Settings**

**RECOMMENDED:** Xilinx recommends that you revisit this procedure to restore your settings to their previous state after installation.

**Note:** You are not able to browse to the remote mapped drives using the Xilinx installer. You need to manually type in your installation path which contains a mapped network drive.

**Batch Mode Installation Flow**

Beginning in Vivado 2015.1, the installer can be run as an unattended batch process. To run unattended, a standard Edition and install location must be specified or a configuration file must be present which tells the installer the install location and which of the tools, devices and options you wish to install. The installer has a mode in which it can generate a reference
option file for you based on common configurations, which you can further edit to customize your installation.

RECOMMENDED: It is recommended that you generate this reference for each new quarterly release, so that new devices, tools, options or other changes will be accounted for in your options file.

To begin using batch mode, open a command shell and change to the directory where you have stored your extracted installer.

Note: For Windows, open the command window with administrator privileges and run the xsetup.bat file, found in the \bin directory, and not xsetup.exe with the options below.

Generate Configuration File

Run: xsetup -b ConfigGen

This will put you in an interactive mode where you will see the following menu. Choose an edition from the list given below.

1. Vivado WebPACK
2. Vivado Design Edition
3. Vivado System Edition
4. Documentation Navigator (Standalone)

After you select an edition, you will be prompted for a location/filename for your configuration file and the interactive mode will exit.

Below is a sample of a WebPACK configuration file:

```plaintext
#### Vivado WebPACK Install Configuration ####
Edition=Vivado WebPACK
Destination=C:\Xilinx
Modules=Vivado:1,Vivado High Level Synthesis:0,Software Development Kit:0,DocNav:0,Artix-7,Kintex-7,Zynq-7000:1
#### Shortcut creation ####
CreateProgramGroupShortcuts=1
CreateShortcutsForAllUsers=0
ProgramGroupFolder=Xilinx Design Tools
CreateDesktopShortcuts=1
CreateFileAssociation=1
#### Post install tasks ####
# Post install tasks can be configured as shown below.
InstallOptions=Configure WebTalk:1,Install and Initialize Trusted Storage Licensing:1,Generating installed device list:1,Install VC++ runtime libraries for 64-bit OS:1,Install Cable Drivers:0,Acquire or Manage a License Key:0,run:xic:1
```

Basically, each option in the configuration file matches a corresponding option in the GUI. A value of 1 means that option is selected, a value of 0 means the option is unselected.
Run the Installer

Now that you have edited your configuration file to reflect your installation preferences, you are ready to run the installer. As part of the installer command-line, you will need to indicate your acceptance of the Xilinx and Third Party license agreements, and confirm you understand the WebTalk Terms and Conditions.

**Xilinx End-User License Agreement (EULA)**


**Third Party End-User License Agreement (EULA)**


**WebTalk Terms and Conditions**

By indicating I AGREE, I also confirm that I have read Section 13 of the terms and conditions above concerning WebTalk and have been afforded the opportunity to read the WebTalk FAQ posted at https://www.xilinx.com/webtalk. I understand that I am able to disable WebTalk later if certain criteria described in Section 13(c) apply. If they don't apply, I can disable WebTalk by uninstalling the Software or using the Software on a machine not connected to the internet. If I fail to satisfy the applicable criteria or if I fail to take the applicable steps to prevent such transmission of information, I agree to allow Xilinx to collect the information described in Section 13(a) for the purposes described in Section 13(b).

There is a command-line switch, -a or --agree for you to indicate your agreement to each of the above. If one of the above is left out of the list, or the agree switch is not specified, the installer will exit with an error and will not install.

**Example Command-Lines**

This is an example of the command-line for a typical new installation using a configuration file.

```bash
xsetup --agree XilinxEULA,3rdPartyEULA,WebTalkTerms --batch Install --config install_config.txt
```

If you wish to use one of Xilinx's default Edition configurations, you do not have to specify the --config option, but since the destination directory is included in the configuration file, you will be required to specify this on the command-line.

```bash
xsetup --agree 3rdPartyEULA,WebTalkTerms,XilinxEULA --batch Install --edition "Vivado System Edition" --location "C:\Xilinx"
```
Chapter 3: Download and Installation

The above command will utilize the default configuration options for the edition specified. To see the default configuration options, use the -b ConfigGen mode as described above. The Vivado installer’s batch mode can also perform uninstallation and upgrades (adding additional tools and devices). For the full list of the installer’s batch options run xsetup -h or xsetup --help.

---

Obtaining Quarterly Releases

Xilinx releases quarterly versions of the Vivado Design Suite tools throughout the year. Each quarterly version contains device support updates, new features and bug fixes. The following sections describe how to obtain updates through the Xilinx Information Center.

Xilinx Information Center

Xilinx Information Center (XIC) is the next generation replacement of XilinxNotify. This functionality resides in the task bar (Windows) and periodically checks for new releases and updates from Xilinx. Users can view and dismiss notifications as well as update installations.

In addition, XIC now includes a cockpit from which you can manage all of your Xilinx tool installations. Update, check licenses or uninstall all from the new Manage Installs tab.
Uninstalling the Vivado Design Suite Tool

Before uninstalling, make sure to have moved any project files you want to keep outside your Xilinx installation directory structure, or they will be deleted.

Note: Xilinx Documentation Navigator is not removed during uninstallation. It is intended to be a standalone application common to multiple versions of Xilinx tools. You need to uninstall it separately if it is no longer required.

Uninstallation

Before uninstalling, make sure to have moved any project files you want to keep outside your Xilinx installation directory structure, or they will be deleted. See below for information on uninstalling Documentation Navigator and Xilinx Information Center.
Uninstalling Documentation Navigator

Xilinx Documentation Navigator will not be removed during uninstallation. It is intended to be a standalone application common to multiple versions of Xilinx tools. If it is no longer required, you will need to uninstall separately either from the Start Menu program group entry ‘Uninstall DocNav’ or through the corresponding entry in the ‘Uninstall or change a program’ control panel option (for Windows).

Uninstalling Xilinx Information Center

Xilinx Information Center will not be removed during uninstallation. It is intended to be a standalone application common to multiple versions of Xilinx tools. If it is no longer required, you will need to uninstall separately through the corresponding entry in the ‘Uninstall or change a program’ control panel option (for Windows).

Uninstalling on Microsoft Windows

To uninstall the Vivado Design Suite tool product, launch the uninstaller from the launcher menu: select Applications > Xilinx Design Tools > Vivado 2016.4 > Uninstall.

Uninstalling on Linux

To uninstall any Xilinx product, select the Uninstall item from that product’s Start Menu folder. For instance, to uninstall Vivado Design Suite: Edition, select Start > All Programs > Xilinx Design Tools > Vivado 2016.4 > Uninstall.

If you do not have a program group entry, use the command line option to uninstall:  
<install_path>\xinstall\Vivado_2016.4\xsetup.exe -Uninstall

Alternatively, use the corresponding entry in the Uninstall or change a program control panel option (for Windows).
Chapter 4

WebTalk

The WebTalk feature helps Xilinx® understand how you use Xilinx FPGA devices, software, and intellectual property (IP). The information collected and transmitted by WebTalk allows Xilinx to improve the features most important to you as part of our ongoing effort to provide products that meet your current and future needs. When enabled, WebTalk provides information on your use of the Vivado Design Suite tools, SDK, and Petalinux.

WebTalk Participation

Your participation in WebTalk is voluntary except when a paid license is not found.

In these cases, WebTalk data collection and transmission always occurs, regardless of your preference settings. For all other cases, data is not transmitted if you disable WebTalk.

The following table summarizes WebTalk behavior for data transmission to Xilinx from your post-route design, based on your Xilinx license, WebTalk install preference, and user preference settings.

Table 4-1: WebTalk Behavior for Bitstream Generation or Route Design Flow

<table>
<thead>
<tr>
<th>License</th>
<th>WebTalk Install Preference Selected as “Enabled”</th>
<th>WebTalk User Preference Selected as “Enabled”</th>
<th>Send WebTalk Data to Xilinx</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebPACK Edition License</td>
<td>X</td>
<td>X</td>
<td>Yes</td>
</tr>
<tr>
<td>WebPACK Edition License</td>
<td>No</td>
<td>X</td>
<td>No</td>
</tr>
<tr>
<td>WebPACK Edition License</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>WebPACK Edition License</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Note:* If the device is a WebPACK device, the Tools first look for a WebPACK license.
Setting WebTalk Install Preference

You can enable or disable WebTalk globally during or after installation as described below. During installation you can enable or disable WebTalk installation options by checking or unchecking the **Enable WebTalk to send software, IP and device usage statistics to Xilinx (Always enabled for WebPACK license)** checkbox.

![WebTalk Install Options](image)

**Figure 4-1: WebTalk Install Options**

You can enable or disable WebTalk installation options using the Tcl command

```
config_webtalk -install on|off
```

- **on** turns WebTalk on for the installation.
- **off** turns WebTalk off for the installation.

Install settings are saved in the following location:

- **Windows 7 and 10**: `<install dir>/vivado/data/webtalk/webtalksettings`
- **Linux**: `<install dir>/vivado/data/webtalk/webtalksettings`

**Note:** You need administrator privileges to write to the install location.
Setting WebTalk User Preferences

You can enable or disable WebTalk user options by selecting **Tools > Options > General** as shown below.

![WebTalk User Preferences](image)

*Figure 4-2: WebTalk User Preferences*

After installation, you can enable or disable WebTalk user options using the `config_webtalk` Tcl command:

```tcl
config_webtalk -user on|off
```

- **on** turns WebTalk on for the current user.
- **off** turns WebTalk off for the current user.
User settings are saved in the following location:

- **Windows 10 or earlier:**
  
  ```
  %APPDATA%\Xilinx\Common\<version>\webtalk
  ```
  where:
  
  %APPDATA% is: 
  
  C:\Users\<user>\AppData\Roaming

- **Linux:**
  
  ```
  %APPDATA%/\Xilinx/Common/<version>/webtalk
  ```
  where:
  
  %APPDATA% is: 
  
  /home/<user>

---

### Checking WebTalk Install and User Preferences

You can also use the `config_webtalk` Tcl command to check the current status of WebTalk settings. The command line option `-info` reports the values for the install setting and the user setting:

```
config_webtalk -info
```

---

### Types of Data Collected

WebTalk does not collect your design netlist or any other proprietary information that can be used to reverse engineer your design. The data Xilinx collects through WebTalk includes:

- Software version
- Platform information (for example, operating system, speed and number of processors, and main memory)
- Unique project ID
- Authorization code
- Date of generation
- Targeted device and family information
For more information on the type of data that is collected, see the Xilinx Design Tools WebTalk web page [Ref 17]. To see the specific WebTalk data collected for your design, open the `usage_statistics_webtalk.xml` file in the project directory. You can also open the `usage_statistics_webtalk.html` file for easy viewing of the data transmitted to Xilinx. Additionally, additional data collection files for sub-flows in the Xilinx tools are also generated which include:

- `usage_statistics_ext_xsim.xml`
- `usage_statistics_ext_labtools.xml`
- `usage_statistics_ext_sdk.xml`
- `usage_statistics_ext_petalinux.xml` (along with corresponding html files)

---

**Transmission of Data**

WebTalk is invoked after bitstream or route design compilation. WebTalk bundles the collected data in an `usage_statistics_webtalk.xml` file and sends this file to Xilinx by https (hypertext transfer protocol secure) post. Every new compilation for a given design overwrites the previous `usage_statistics_webtalk.xml` file. WebTalk also writes an HTML file equivalent `usage_statistics_webtalk.html` file for easy viewing of the data transmitted to Xilinx. WebTalk also writes to the `vivado.log` (or `runme.log`) file that contains additional information about whether the file was successfully transmitted to Xilinx.
Obtaining and Managing a License

The Xilinx® Product Licensing site is an online service for licensing and administering evaluation and full copies of Xilinx design tools and intellectual property (IP) products. This chapter describes the FLEXnet license generation functionality of the Product Licensing Site.

Licensing Overview

Two Product Licensing Methodologies

There are now two ways in which Xilinx enforces the Xilinx End-User License Agreement at run time in the Xilinx design tools.

- **Certificate-Based Licenses**: This is the license enforcement method Xilinx introduced for the ISE® Design Suite in the ISE 11.1 release. A certificate, commonly referred to as a “license file (.lic)” is issued from the Xilinx Product Licensing Site. The certificate is matched to a given machine, server or licensing dongle using your entering host-id which uniquely identifies the machine. This license certificate must remain present on the machine and in the license search path, because the Vivado tools need access to this file to check for a valid license feature during run time.

- **Activation Licenses**: Instead of requiring a file to be present to authorize a machine, Activation uses a trusted area on the client or servers hard-drive to store the authorization credentials. Most new Vivado tools licenses purchased after April, 2014 utilize a licensing technology referred to as Activation-based licensing. This trusted storage area should be automatically installed and initialized on Windows operating systems if Vivado was installed with Administrative privileges. If not, or if using Linux, then the trusted storage area must be installed/initialized prior to any other Activation licensing activities. See either Certificate-Based Node Locked License or Activation-Based Floating License. When the Vivado tools look for a license feature, they are allowed to run if this trusted storage area contains the proper authorization. Because activation-based licenses do not use a license file, they will not work with USB license dongles.

*Note*: Flex-ID Dongle licensing for Xilinx Software is supported only on Windows platforms.
Certificate Licensing Terminology

- **Host ID**: An identifier, placed within certificate licenses, which binds the license to the computer using this identifier. Typical identifiers are: Hard-drive volume ID, Ethernet port MAC address, or USB Dongle ID.

- **Node-Locked License**: A node-locked license allows for the use of a single seat of a product entitlement on a specific machine.

- **Floating License**: A floating license resides on a network server and enables applications to check out a license when they are invoked. At any one time, the number of licenses for simultaneous users is restricted to the number of license seats purchased.

- **License Rehosting**: The act of changing the host ID of a generated license due to machine hardware changes, hard-drive failure or the moving of a license from one machine to another.

- **License Deletion**: The act of removing a license from a machine, and having the entitlement placed back into the Xilinx Product Licensing Account.

- **Affidavit of Destruction**: A click through agreement by which you certify that the license file (.lic) for a rehosted or deleted license will be destroyed and no longer used.

Activation Licensing Terminology

- **Client License**: A client license allows for the use of a single seat of a product entitlement on a specific machine. This is the activation-based equivalent of a certificate-based node-locked license.

- **Server License**: A server license is the activation-based equivalent of a certificate-based floating license. A server license resides on a network server and enables applications to check out a license when they are invoked. At any one time, the number of licenses for simultaneous users is restricted to the number of license seats purchased.

- **Trusted Storage**: The area where activation license host information and authorizations are stored.

- **Request Creation**: Activation licensing is based upon a request/fulfillment system. A request for a new license must first be recorded into trusted storage. This is done automatically by the Vivado License Manager whenever you use the Connect Now or Save Link As Button in Obtain License screen or by using similar command-line arguments for the xlicsrvrmgr tool, required for setting up a floating Activation license. After a request identifier is created, it is sent to the Xilinx Product Licensing Site along with the host information. When a license is generated on the Licensing Site, a fulfillment XML file is created with this same request identifier. When the activation fulfillment XML file is loaded into trusted storage, activation will be successful only if the request identifier on the fulfillment matches the one stored in trusted storage.
After the license is activated, the request becomes inactive and a new request can be made for additional licenses.

- **Return License:** With activation, license rehosting, license deletion and affidavits of destruction are no longer necessary. Activation features a methodology by which you can initiate a return of a license to Xilinx from the client or server machine. When the return request is made, the license is disabled on the local machine, and a return request is sent to the Xilinx Product Licensing Site. After processed, the return request causes an entitlement to be placed back in your Product Licensing Account, and a message is sent to trusted storage to remove the returned license from the machine.

**License Compatibility**

The Vivado 2014.1 and later releases recognize both certificate and activation-based licenses. If the license versions and dates are valid for the tool version being used, it does not matter whether the license is certificate or activation-based.

**Differences with Activation Licenses**

To authorize the trusted storage area, activation records need to be sent from the Xilinx Product Licensing Site to the client or server machine. Currently, this is done by using XML files with encrypted authorizations. When you generate an Activation license, you receive an XML file by email, much like you might have received a certificate file (.lic) in the past. The difference is that certificate .lic files need to be continually accessed by the Xilinx software, and so must be retained and in a valid license search path. The XML activation record is used to load the authorization into the trusted storage area. After the authorization has been loaded, the XML activation record is no longer needed.

To generate licenses based on activation entitlements, a request for a license must first be made into the client or server computer’s trusted storage area. For client (node-locked) activation license requests, Vivado License Manager or the command-line utility xlicclientmgr must be used. For server (floating) license requests, the command-line utility xlicsrvrsmgr must be used. For more information on the xlicclientmgr or xlicsrvrsmgr utilities, see the Xlicclientmgr Command-Line Utility or Xlicsrvrsmgr Command-Line Utility section.

After this request is processed, a URL to the Xilinx Product Licensing Site will be generated and will contain the id of the request along with specific machine identification information of the Xilinx Product Licensing Site. This URL should be placed into a web browser, and if activation entitlements exist, they are accessible in the Activation-Based Licenses section of the Create New Licenses tab of the Xilinx Product Licensing Site.

If you enter the Xilinx Product Licensing Site directly or through older Xilinx license managers, the machine identification necessary to generate an activation-based license will not be present. In this case, the Activation-Based Licenses section of the website will be inactive, and only certificate licenses will be available for generation.
Chapter 5: Obtaining and Managing a License

Generating/Installing/Managing Activation-Based Licenses

Activation-Based Node-Locked License

Getting Started

Activation Exceptions

If you meet any of the following conditions, you are not a candidate to use Activation for your licensing solution. Please contact Xilinx Development System Customer Service for an alternate licensing solution.

- License dongles are not supported by Xilinx’s activation licensing. If you wish to utilize your existing dongles, only certificate-based licenses should be used.
- If you are creating a license for a secured area where files are not allowed to be exported, certificate-based licenses which support the legacy host ID structure are a better fit.

Initializing Trusted Storage

Windows: If you are using Windows and installed with Administrative rights, the trusted storage area should have been installed and initialized automatically. If trusted Storage has not been initialized, perform the following steps:

1. Open a command window in Administrative mode by typing `cmd` in the Windows Start Menu search box, right clicking on the `cmd.exe` icon and choosing Run as administrator.
2. Run `<Vivado Tools Directory>/Vivado/2016.4/bin/unwrapped/win64.o/installanchorserver.exe`.

Linux: Trusted storage must be manually installed and initialized on Linux by performing the following steps:

1. With root or sudo access, open a command-line shell.
2. Run `<Vivado Tools Directory>/Vivado/2016.4/bin/unwrapped/lin64.o/install_fnp.sh`

Requesting a Node-Locked License From Your Machine

In order to generate node-locked (client) activation-based licenses, you must use either the Vivado License Manager GUI, or the `xlicclientmgr` command-line executable to access
Chapter 5: Obtaining and Managing a License

the Xilinx License Management site. Failure to use one of these tools, and going to the Xilinx License Manager website directly in a browser will result in all activation-based licenses being non-selectable. The following instructions are for using the Vivado License Manager GUI to access the Xilinx License Management website.

1. Launch Vivado License Manager
   a. For Windows 7 and 10: Select Start > All Programs > Xilinx Design Tools > Vivado 2016.4 > Manage Xilinx Licenses.
   b. For Windows 8.1: Run the Manage Xilinx Licenses app from the full listing of Apps on your Start screen.
   c. For Linux: Type vlm in a command-line shell.

2. In the left window frame select Obtain License which is located under the Get License section.

3. In the main window frame, select either Get Free Licenses, Start 30-Day Evaluation or Get My Purchased Licenses (not Start now) and click the Connect Now button (Figure 5-1).

4. Your default web browser should now open with a Xilinx login screen.

   Note: If your machine is not currently connected to the internet or is having proxy issues, please click the Save Link As button. This will allow you to save the required information into an HTML file. This HTML file can be opened by a web browser on any machine that is connected to the internet.

**Generating a Node-Locked Activation License on the Xilinx License Management Website**

Whether Vivado License Manager launched your web browser, or you manually launched a browser with the HTML file provided by the Save Link As command, you should now be at the Sign In To The Xilinx Licensing Site screen.

1. Use your Xilinx.com username and password to sign in and confirm your address information.

2. Select the licensing account which contains your licenses from the Account drop-down menu, if necessary.

![Figure 5-1: Obtain License](image)
3. Scroll down, if necessary, to the Activation Based Licenses section of the webpage (Figure 5-2).

4. Select the Activation licenses of your choice.

Note: Once you check an entitlement in either the “Activation Based Licenses” area or the “Certificate Based Licenses” area, the other area will automatically become inactive. Activation and Certificate licenses must be generated separately, although multiple licenses of the same license type may be selected. To reactivate both areas, uncheck all licenses in that area.
Chapter 5: Obtaining and Managing a License

Product Licensing

5. Select the **Activate Node-Locked License** button.

6. On the pop-up dialogs confirm each page of information is correct by pressing the **Next** buttons until the license generation begins.
Installing a Node-Locked Activation License On Your Machine

One-Step Activation Method

Beginning in Vivado 2014.3, pressing the Connect Now button in the Vivado License Manager causes the VLM to go into polling mode. After a two-minute delay, VLM shows the following dialog box (Figure 5-3).

If your internet and proxy connects are correct, Vivado License Manager detects the existence of your Xilinx_License.xml file soon after you press the final Next button on the license generation dialogs in step 3. VLM will then automatically download and install the .xml file for you, immediately activating your license and presenting you with a Success dialog. You may view your installed license in the View License Status page under the Manage License heading in the left most window frame.

Your Xilinx_License.xml file will be e-mailed to you for your records, but no further action with this file is required.

Manual Method

The One-Step Activation polling stops after about 15 minutes. If it has taken you longer than this to generate your license file, if you manually cancelled the polling, or if you accessed the Xilinx License Management Website on a different machine because yours was not connected to the internet, you will need to utilize the manual method for loading your license onto your machine.

1. Save the activation fulfillment file (.xml) attached to thee-mail to a temporary directory on your local system.
2. Run the Vivado License Manager.
3. On the left hand frame of VLM, choose Load License under the Get License section
4. Click the Activate License button.
5. Browse to your activation fulfillment file (Xilinx_License.xml) and click **Open**.

6. This loads your activation fulfillment into trusted storage, where it is verified and the machine authorized for the corresponding tools.

**Activation-Based Floating License**

**Getting Started**

**Activation Exceptions**

If you meet any of the following conditions, you are not a candidate to use Activation for your floating license server. Contact Xilinx Development System Customer Service for an alternate licensing solution.

- Triad (triple-redundant) floating license server configurations are not supported by Xilinx's activation licensing. Certificate-based licenses must be used with triple-redundant floating servers.

- SUN-OS based activation floating license servers are not supported by Xilinx. Certificate-based licenses do still support the SUN-OS.

- If you are creating a license for a secured area where files are not allowed to be exported, certificate-based licenses which support the legacy host ID structure are a better fit.

**Initializing Trusted Storage**

Trusted storage must be manually installed and initialized on your floating license server. All the files required to install, initialize and serve floating licenses are available in the platform specific ZIP files located on the Xilinx Download Center in the License Management Tools section of the current Vivado release.

**Windows:**

1. Extract the License Management Tools archive onto your disk. A permanent location is suggested as you will need the `lmgrd` and `xilinxd` files in this archive to actually serve your licenses.

2. Open a command window in Administrative mode by typing `cmd` in the Windows Start Menu search box, right clicking on the `cmd.exe` button and choosing Run as administrator.

3. **Run** `< Server Tools Directory>\<Tools Version>\win64.o\installanchorservice.exe`.

**Linux:**

Trusted storage must be manually installed and initialized on Linux by performing the following steps.
Chapter 5: Obtaining and Managing a License

1. Extract the License Management Tools archive onto your disk. A permanent location is suggested as you will need the `lmgrd` and `xilinxd` files in this archive to actually serve your licenses.

2. With root or sudo access, open a command-line shell.


**Requesting a Floating License From Your License Server Machine**

To generate floating (server) activation-based licenses, you must use the `xlicsrvrnmgr` command-line executable run from your server machine to access the Xilinx License Management site. Failure to use this tool and going to the Xilinx License Manage website directly in a browser results in all activation-based licenses being non-selectable. To generate a floating license from an entitlement in your Xilinx License Management Account, do the following.

1. From your server tools directory (above), run `xlicsrvrnmgr -cr <outputdir>/server_req.xml`.
   
   This creates a license request into the trusted storage area which causes XML and HTML files to be output containing your server’s Host ID information.

2. Open the `server_req.html` file in the browser of your choice.
   
   This.html file effectively contains a URL with the Host ID information that activation requires to lock a floating license to your server.

3. Your web browser should now open with a Xilinx login screen.

   **Note:** If your machine is not currently connected to the internet or is having proxy issues you may take this HTML to a web browser on any machine that is connected to the internet.

**Generating a Floating Activation License on the Xilinx License Management Website**

1. From the **Xilinx Licensing Site** login screen, enter your Xilinx.com username and password to sign in and confirm your address information.

2. Select the licensing account which contains your licenses from the **Account** drop-down menu, if necessary.

3. Scroll down, if necessary, to the Activation Based Licenses section of the webpage (**Figure 5-4**).

   **Note:** After you check an entitlement in either the “Activation Based Licenses” area or the “Certificate Based Licenses” area, the other area will automatically become inactive. Activation and Certificate licenses must be generated separately, although multiple licenses of the same license type may be selected. To reactivate both areas, uncheck all licenses in that area.
4. Select the Activation licenses of your choice and click the **Activate Floating License** button.

5. A dialog will open where you can specify the number of license seats from your entitlement that you wish to assign to this server in the **Requested Seats** field. The default is 0, but a non-zero number is required to continue.

   **Note:** If your Vivado subscription was purchased or renewed after the launch of Vivado 2016.4, a borrow feature is enabled on your floating license. For more information on the borrow feature, see **Borrowing Licenses** below.

6. If the borrow feature is enabled on your licenses, you will see an additional field to the right called **Borrowed Seats** (Figure 5-5). Here you will specify the number of requested seats that are eligible to be borrowed. The default is 0, which means no seats will be available for a user to borrow and you may enter any number up to the number of requested seats in the previous column.

7. After inputting the requested and borrowed seats, press the **Next** buttons until the license generation begins.
8. Your Xilinx_License.xml file will be e-mailed to you. You will need this file to finish installing and serving your license

**Installing and Serving a Floating Activation License File On Your Machine**

After you receive your Xilinx_License.xml file, please save it off to a local directory. The following steps instruct you on how to install the license, and how to serve it on your floating server.

1. From your server tools directory (above), run xlicsrvrmgr -p <response filename i.e. (xilinx_license)>.xml.
2. This will store the license information into your trusted storage area.
3. Verify that the license is installed by viewing your trusted storage area: xlicsrvrmgr –v “format=long”.

**License File Requirements**

Before completing the following steps, there are some things that need to be understood about Flexera’s lmgrd license server utility. LMGRD and other familiar FLEX server utilities are still used for serving and managing activation-based floating licenses. While licenses in trusted storage are automatically found and served by lmgrd, lmgrd requires that a license file (.lic) be specified. For activation-based floating licenses, the license file is just needed to specify certain network basics.

```
SERVER <host_name> <host_id> <port>  (Xilinx’s default port=2100)
USE_SERVER
VENDOR xilinxd
```

If you already going to serve an existing Xilinx license file, like for Xilinx IP or ISE Design Suite, there is nothing further needed. If you are only going to be serving the activation-based licenses on the server, then you will need to create a basic license file (.lic) with the information listed above.

4. Ensure that a license file (.lic) meeting the minimum criteria above is present.
5. Run lmgrd to serve your licenses.

**Windows:**

```
<Server Tool directory>\win64.o\lmgrd -c <path_to_license>\<license filename>.lic -l <path_to_license>\<log filename>.log
```

**Linux:**

```
Note: For Linux users - lmgrd command requires library paths to be set. Xilinx provides a shell script to set this for you, lmgrd.sh. If you use the lmgrd command-line tool alone, you are likely to see an error
```

Vivado Design Suite 2016.4 Release Notes
UG973 (v2016.4) November 30, 2016
www.xilinx.com
<Server Tool directory>/lnx64.o/lmgrd.sh -c
<path_to_license>/<license file>.lic -l <path_to_license>/<log filename>1.log

**IMPORTANT:** If you are using a Windows 8.1 machine as your floating server or if you wish to support borrowing from your server, you must use the 11.13.1.3 version of `lmgrd` and `xilinxd` found in the Vivado 2016.x Server Tools download. Re-initialization of trusted storage will be required when moving from the previous 11.11.0 `lmgrd` and `xilinxd` to 11.13.1.3. If you do not wish to enable borrow and are not using a Windows 8.1 machine, you may continue to use your existing 11.11.0 `lmgrd` and `xilinxd`.

---

**Borrowing Licenses**

Beginning with Vivado 2015.1, Xilinx introduces the ability to borrow activation-based licenses from a compatible server to the trusted storage of your local machine. This means that, for a period of time specified during the borrow request process, the license seat count on the server is decremented by 1, and the license is activated in the local trusted storage of the borrow client. This allows the borrow client to then have an effective node-locked Activation license, which can be taken off network, etc. At the end of the borrow time period, the license will automatically deactivate on the client’s machine, and will be restored to the floating server. Vivado also gives you the ability to restore a license to the floating server early, if the borrowed seat is no longer needed.

**Note:** Borrowing licenses from a virtual machine (VM) to a physical machine is currently not supported. For more information, see [Answer Record 63727](https://www.xilinx.com).

---

**Is The Server License Borrowable?**

Existing Vivado floating activation-based licenses issued prior to April, 2015 cannot be borrowed. When your Vivado subscription comes up for renewal after April, 2015, new floating activation-based entitlements from that renewal will be borrowable. However, the decision to allow borrow or not, or how many seats of a total entitlement are borrowable rests with administrator generating the license and is made during the license generation process.

From a client, it is straightforward to determine if a license is borrowable using Vivado License Manager, and this is discussed in the [Borrowing Licenses](#) section.

---

**Borrowing a License**

At this time, it is only possible to borrow from an activation-based floating server to a node-locked client. The following steps cover how to borrow a license using Vivado License Manager.

1. Open VLM and select **Borrow/Restore License Seat** which is located under the **Manage License** section in the left-hand window pane.
2. In the main area, all floating servers on your network will be queried to see if they contain borrowable activation-based licenses (Figure 5-6).

![Vivado Design Suite License Manager](image)

**Figure 5-6: Borrow/Restore License Seat**

3. Select the license you wish to borrow and click the **Borrow/Restore** button.

In **Figure 5-6**, there is a license row where the text is gray, but the background is the normal coloration. This indicates that this license is allowed to be borrowed, but cannot be borrowed at the moment. In this case, it is because all borrowable seats have already been borrowed. If the background of a row is gray, as in the Figure, this is an indication that the license cannot ever be borrowed. Common causes for this are older server Flex software (11.11.0 or 11.6.0 - 11.13.1.3 is required), or the license itself is not setup for borrow (Example: A 2014.x era floating license.)

4. A Borrow Confirmation screen will appear, this is where you will need to specify how long you wish to borrow the license. This is done in the **Set Borrow Expiration Date** dialog box highlighted in Yellow (Figure 5-7).
Chapter 5: Obtaining and Managing a License

The default borrow date is set 30-days from the current date, or at the expiration date of the server license, whichever comes first. You will not be allowed to enter a borrow end-date that is greater than the license expiration date.

5. Click the Borrow button on the confirmation screen and the license will be decremented from the server and added to the client's local trusted storage.

The screen will refresh, and you will see that a license seat has now been added to the list with a value of Restore in the first column.

**Figure 5-7: Set Borrow Time-Limit**

Restoring a Borrowed License

If you do not wish to keep the borrowed license for the entire time you specified, you may restore it to your local license server.

1. Open VLM and select Borrow/Restore License Seat which is located under the Manage License section in the left-hand window pane.

2. Select the license you wish to restore. Eligible licenses will have Restore listed next to them in the Action column (Figure 5-8).

3. Click the Borrow/Restore button and the confirmation dialog box appears.

4. Specify the Port that the floating license server is using.

Unfortunately, Vivado License Manager cannot detect which port the license server is using. VLM prepopulates the default Xilinx license server port, but if your server is using something different, it needs to be specified. Specifying an incorrect port will disable...
the license on the local client machine, but the seat will not be available to others until
the original borrow time period expires.

5. Click the Restore button and the license will be rendered inactive on the client machine,
and the license count on the server will be incremented by one.

**Returning Licenses**

For information on returning certificate-based licenses from your machine to Xilinx, please
see Modifying Licenses. Activation-based licenses can returned to Xilinx through either
Vivado License Manager (Node-Locked) or the xlicsrvmgr command line utility
(Floating).

**Returning Node-Locked (Client) Licenses**

1. Open the Vivado License Manager.

2. In the left-hand window pane click Return License to Xilinx which is located under the
   Manage License section.

3. In the main area of the screen, a list of the node-locked licenses currently in your trusted
   storage area will appear.

   If No appears in the Disabled column, this means that license is an active license and is
   eligible to be returned. If Yes appears in the Disabled column, this usually means a
   return has already been attempted, but not completed (your account has not been
   credited).

4. Select the license you wish to return and verify the contents of the license by looking in
   the Details section at the bottom of the main area.

5. Click Return.
6. An important confirmation dialog appears (Figure 5-9).

   ![Figure 5-9: Return License to Xilinx](image)

   When you attempt to return an Activation license, it is first marked disabled in your trusted storage area, which means it can no longer be used on your machine, before VLM attempts to contact the Xilinx License Management website and place the entitlement back in your account. Since this cannot be undone, it is recommended that you ensure a connection to the internet.

7. Vivado License Manager will contact the Xilinx License Management website and will automatically credit your account with the license return.

**Returning Floating (Server) Licenses**

To return a license from a floating license server to Xilinx, you must do so from that server using the xlicsrvrmgr utility.

1. Create the return request.

   ```bash
   xlicsrvrmgr -cr <return request.xml> -r <fulfillment ID>
   ```
Chapter 5: Obtaining and Managing a License

Notice how both the –cr (create request) flag AND –r (return request) flag are used. Fulfillment ID can be obtained by running the xlicsrvrmgr -v "format=long" command

2. Send the return request to Xilinx.

   xlicsrvrmgr -returnTransaction "request=<return request.xml>" "response=<response filename.xml>" "proxy=<proxy:port>"

   This command sends the return request.xml to Xilinx, where the return is made and your account is credited with the returned seat. A response XML is generated which you will use for Step 3.

3. Process the return response.xml file which removes the deactivated license from the local server’s trusted storage.

   xlicsrvrmgr -p <response filename.xml>

Generating/Installing Certificate-Based Licenses

For certificate-based licenses, as long as you know the Flexera Host ID (Ethernet MAC ID, Drive Serial Number or Dongle ID) you wish to lock your license to, you do not need to enter the Xilinx License Management site from one of our utilities. Instead, you may go directly to www.xilinx.com/getlicense. After logging in and selecting your account, you may select products as described in the Product Selection section.

After one or more licenses are selected on the Create New Licenses page, click the Generate License button corresponding to the type of license file you are generating (client/node-locked or server/floating).

The step-by-step instructions below are for generating a floating certificate-based license as this process contains a superset of all other certificate-based license generation flows.
Certificate-Based Node Locked License

After generating a license file, you will receive an email from ‘xilinx.notification@entitlenow.com’.

1. Save the license file (.lic) attached to the e-mail to a temporary directory on your local system.

2. Run the Vivado License Manager:
   - For Windows 10 or earlier: Select Start > All Programs > Xilinx Design Tools > Vivado 2016.4 > Manage Xilinx Licenses.
Chapter 5: Obtaining and Managing a License

- Windows 8.1: Run the Manage Xilinx Licenses app from the full listing of Apps on your Start screen.
- For Linux: Type vlm in a command-line shell.

3. On the left hand pane of Vivado License Manager, expand Getting a License and choose Load License.

4. If you received a certificate license (.lic) file, click the Copy License button on the Load License screen.

5. Browse to your license file (Xilinx.lic) and click Open.

6. This action copies the license file to the <Homedrive (typically C)>:\Xilinx (Windows) or <Home>/.Xilinx directory of your computer where it will be automatically found by the Xilinx tools.

Certificate-Based Floating License

1. Select the number of seats required for each product license.

   This is for floating licenses only. All node-locked licenses are for one seat. The number of seats available for a product entitlement is automatically maintained by the system. The Requested Seats field is populated, by default, with zero, although you are allowed to enter any number up to the full number of seats remaining on the product entitlement. A product is removed from the product entitlement table once all seats have been generated.

2. Enter system information.

   For floating certificate-based licenses, the first field is redundancy. A triple-redundant server configuration, also known as a triad, provides a fail over for the license manager software. As long as two of the three servers are running, the license manager can continue to run. This does not apply to node-locked licenses.

   The system information is pre-populated in the Host ID drop-down menu if you arrived at the Product Licensing Site from a link within the Vivado License Manager. If you do not have pre-populated system information, or if you want to add a different host, select the Add a host option.
Chapter 5: Obtaining and Managing a License

The Host ID value uniquely identifies the machine to which your design tools or IP is licensed. You can choose a Host ID Type to be a MAC address, a hard drive serial number or a dongle ID.

For activation-based licenses, all required system information is passed from the Vivado License Manager, or the command-line tools, through the web-browser’s URL. There is no need to manually enter host information for either client or server-based activation licenses.

**Note:** Not all host ID types are supported for all operating systems. The easiest way to obtain your host ID is to run Vivado License Manager on the machine that serves as the license host.

3. Add a comment.

Adding a comment to the license key file makes it easier for an administrator to track the allocation of design tools and IP product entitlements among users.

4. Click **Next**.

The Review License Request form opens.
5. Review your selections.

6. If you are satisfied with your selections, click **Next**.

---

**End-User License Agreements**

Xilinx Design Tools and No Charge IP product End User License Agreements (EULAs) are agreed to during the product installation process. A complete copy of this license agreement is located at: `<install directory>/.xinstall/Vivado_2016.4/data/unified_xilinx_eulas.txt`

If you license IP products, you must accept the terms of the associated IP product EULAs before the license file can be generated.
Chapter 5: Obtaining and Managing a License

Third-Party Licenses

A complete copy of the third-party licenses is located at:
<install_directory>/install/Vivado_2016.4/data/unified_3rd_party_eula.txt

License Generation Confirmation

When you finish generating the licenses, you will receive a confirmation message summarizing your licensing activity.

![License Generation Confirmation](image)

You will also receive a license generation confirmation email. This message contains the generated license key file as an attachment. Add xilinx.notification@entitlenow.com as a trusted sender in your email address book.

If you do not receive your license by email, you can download it directly from the Xilinx Licensing Site. See the Managing Licenses on the Xilinx Product Licensing Site section for details.

Serving Certificate-Based Floating Licenses

For existing FLEXnet license servers serving certificate-based licenses, a common practice is to copy the contents of the license file, mailed from xilinx.notification@entitlenow.com, into the existing license file on your FLEXnet server.

For existing FLEXnet license servers serving activation-based licenses, load the license into trusted storage using the command: xlicsrvrmgr -p <responseFileName>

Note: Restart the floating license server to ensure the new Xilinx licenses are enabled.
For New License Servers

1. Download the appropriate Xilinx FLEXnet license utilities for your server's operating system from the Xilinx Download Center at https://www.xilinx.com/download/index.htm.

2. Unzip these utilities into a destination directory. Xilinx recommends you place this directory into your application search path.

3. After the FLEXnet utilities are installed, run the following commands to start the floating license server:
   - Linux
     
     `<Server Tool directory>/lnx64.o/lmgrd.sh -c <path_to_license>/<license file>.lic -l <path_to_license>/<log filename>1.log`
   - Windows
     
     `<Server Tool directory>\win64.o\lmgrd -c <path_to_license>\<license filename>.lic -l <path_to_license>\<log filename>.log`

Client Machines Pointing to a Floating License

1. Run the Vivado License Manager (VLM).

2. Click the Manage Xilinx Licenses tab.

3. On the Manage Xilinx Licenses tab, enter the network path to the license server in the port@server format into the XILINXD_LICENSE_FILE field.

4. Click Set. The default Xilinx port number is 2100.

For Linux operating systems, licensing environment variables cannot be set using the Vivado License Manager (VLM). The environment variable fields are read only, so they are grayed out and there are no Set buttons. The environment variable must be set using the appropriate OS shell and commands.

Managing Licenses On Your Machine

Vivado License Manager

The Vivado® License Manager (VLM) is intended to assist with license generation for Node-Locked (Client) Activation and Certificate-based licenses only. For license servers using activation-based licensing, see the section entitled Xlicsrvrmgr Command-Line Utility.
Vivado License Manager is installed with Vivado Edition and many standalone tool installations.

To Open the Vivado License Manager:

- On Linux, type `VLM` from a command-line shell that has the Xilinx environment loaded.
- On Windows 10 or earlier, you can run this from the Start menu at `Start > Xilinx Design Tools > Vivado 2016.4 > Manage Xilinx licenses`.
- On Windows 8.1, run the `Manage Xilinx Licenses` app from the full listing of Apps on your Start screen. You can also run Vivado License Manager from the Help menu of Vivado: `Help > Obtain A License Key` or `Help > Manage License`.

The typical tasks that Vivado License Manager is used for are:

- **Obtaining A License**: Choose from several license options and go to the Xilinx Product Licensing Site to complete the license generation process. To generate a license for an activation-based entitlement, Vivado License Manager should be used to access the Xilinx Product Licensing Site. This can be done on the **Obtain a License** screen by...
pressing Connect Now, if an internet connection is present, or by pressing Save Link As if one is not. Save Link As, saves the information that Vivado License Manager normally passes to the Xilinx Product Licensing Site through parameters on the URL, into an HTML file for later use.

- **Viewing License Status**: See which licenses are visible to the local machine. This is a useful view for debugging licensing issues.

- **Loading Licenses Onto a Local Machine**: After a certificate license (.lic) or Activation fulfillment (.xml) file has been received, they can be placed into the appropriate location on the machine. For step-by-step instructions, see the Installing Your License key section for your license type below.

- **Returning a License to Xilinx**: (Activation-based licenses only) If a license is no longer needed on a local machine, it can be returned to Xilinx and the entitlement credited back to the licensing account.

- **Viewing and Setting (Windows) License Search Locations**: Vivado tools will look in several default locations to try to find authorization to run. If your license is located elsewhere on the machine or on a floating license server, a path to that license must be specified.

---

**RECOMMENDED**: It is recommended that the XILINXD_LICENSE_FILE environment variable be used to specify Xilinx license file locations. LM_LICENSE_FILE can also be used, but is mainly intended for non-Xilinx or legacy license path use.

---

**Xlicclientmgr Command-Line Utility**

Xlicclientmgr is a command-line utility for creating Activation license requests and otherwise managing a client (node-lock) computer’s trusted storage area. See the details on the Xlicsrvrmgr utility below for creating and interacting with a server (floating) computer’s trusted storage area.

Xlicclientmgr can do many of the same functions the graphical Vivado License Manager utility can do, but is limited to servicing activation licenses. Xlicclientmgr is located in the `<Install Directory>\Vivado\2016.4\bin` directory of a Xilinx tool installation.

**Key Xlicclientmgr Command-Line Flags**

- `-help all`: Prints usage information for xlicclientmgr.
- `xlicclientmgr -v “format=long”`: Displays a list or detailed list of the contents of the machine’s trusted storage area.
- `-cr <XML RequestFileName> [-r fulfillmentID]`: Creates a request in trusted storage. This is the command used to request an activation license from Xilinx. It will create an activation request in XML format, as well as an HTML file containing a
URL with information for use with the Xilinx Product Licensing Site. If -r is used, it will create a request to return the license with the specified fulfillment ID to Xilinx.

- \(-p<responseFileName>\): Process XML file into trusted storage. This is essentially the same command run by the **Activate License** button on Vivado License Manager’s Load License screen.

- \(-returnTransaction "request=<requestFileName>" "response=<responseFileName>" "proxy=<host:port> [<proxy userId> <proxy passwd>]"\): Transmits a return request from local machine to the Xilinx Product Licensing Site.

**Note:** A return request must already exist in the form of an XML file. This return request must have already been created by a previous run of **xlicclientmgr** using -cr and -r options together.

### XlicsrvrMgr Command-Line Utility

The XlicsrvrMgr is a command-line utility for creating Activation license requests and otherwise managing a floating license server computer’s trusted storage area. For floating license generation on activation-based entitlements, the OMS website must be accessed by first running the XlicsrvrMgr utility. Vivado License Manager supports client (node-lock) activation transactions only, but floating server license requests require xlicsrvrMgr.

The XlicsrvrMgr is contained in the License Management Tools download located at: https://www.xilinx.com/download/index.htm. The utility is also located in the \<Install Directory\>\Vivado\2016.4\bin directory of a Xilinx tool installation.

### Before Running XlicsrvrMgr The First Time

If this is the first time xlicsrvrMgr is to be run on a floating license server, then you will need to ensure that the computer’s trusted-storage area, where activation authorizations are stored, is first installed and initialized. In the License Management Tools download, you will find an initialization utility that varies by OS. Run the commands as specified below from the \<OS><bitwidth>.o directory where the License Management Tools were unzipped. (For Example: c:\servertools\win64.o):

- **Windows:** installanchorservice.exe xilinxd Xilinx-Design-Suite-Software
- **Linux:** install_fnp.sh

### Key XlicsrvrMgr Command-Line Flags

- **-help all:** Prints usage information for xlicsrvrMgr.
- **-v or -v “format=long”:** Displays a list or detailed list of the contents of the machine’s trusted storage.
- **-cr <XML RequestFileName> [-r fulfillmentID]:** Creates a request in trusted storage.
Chapter 5: Obtaining and Managing a License

This is the command used to request an activation license from Xilinx. It will create an activation request in XML format, as well as an HTML file containing a URL with information for use with the Xilinx Product Licensing Site. If --r is used, it creates a request to return the license with the specified fulfillment ID to Xilinx.

**Note:** If you wish to create a new activation license for a floating license server, this -cr command must be run and the URL in the resulting HTML file must be used to access the Xilinx Product Licensing Site. If you enter the product licensing site directly or through links, the Activation section of the website will be inactive.

- `-p <responseFileName>`: Process XML file into trusted storage.
- `-returnTransaction "request=<requestFileName>" "response=<responseFileName>" "proxy=<host:port> [<proxy userId> <proxy passwd>] "`: Transmits a return request from local machine to the Xilinx Product Licensing Site.

**Note:** A return request must already exist in the form of an XML file. This return request must have already been created by a previous run of xlicclientmgr using -cr and -r options together.

---

**Using the Xilinx Product Licensing Site**

The Xilinx Product Licensing site is where both certificate and activation-based licenses are generated, where certificate-based licenses are modified and where information about license orders reside. As mentioned earlier, creation of activation-based licenses requires you to access the Xilinx Product Licensing Site from the Vivado License Manager or appropriate command-line utility.

You can access the Xilinx Product Licensing Site in various ways depending upon the type of license being generated.

- If you purchased products which use certificate-based licenses, follow the link included in your order confirmation email. It provides direct access to an account containing your product entitlements.
- If you purchased products which use activation-based licenses, use Vivado License Manager, xlicclientmgr or xlicsrvrmgr to generate your license request. The license request information is then sent from the Vivado License Manager or command-line tools through a URL to access the account containing your product entitlements.
- To evaluate IP products, go to [https://www.xilinx.com/ipcenter](https://www.xilinx.com/ipcenter) and follow the Evaluate link on the IP product page of interest.
- To access the Product Licensing Site directly, go to [https://www.xilinx.com/getlicense](https://www.xilinx.com/getlicense). By accessing the site this way, you will not be able to create activation-based licenses,
but you will be able to create certificate-based licenses as well as perform license account management functions.

When entering the Xilinx Product Licensing Site, you must first register or enter your registration information.

5. You must first sign in. If you already have a Xilinx user account, enter your user ID and password, and then confirm your contact information is current. If you do not have an account, click the Create Account button.

Product Selection

To begin the license generation process for products you have purchased or want to evaluate:

1. Select a product licensing account from the Account drop-down list.

   **Note:** This selection is not available if you are entitled to evaluation or free products only.
2. Enter product voucher codes for design tools or IP product licenses purchased with kits or for tools purchased from the Xilinx online store (optional).

3. Add evaluation or no-charge IP product entitlements to the product entitlement table (optional).

4. Make your product selections from the product entitlement table.

Entitlements are grouped into two broad categories: certificate-based or activation-based licensing. The type of product entitlements available are Full (purchased), No Charge, or Evaluation. Full and No Charge licenses have a subscription period of one year. Design tool evaluation is for 30 days and IP evaluations are for 120 days.

Floating/server and node-locked/client licenses cannot be combined in the same license file. Selecting an entitlement that contains only one license type causes the **Generate** button for the other license type to become inactive. Likewise certificate-based and activation-based entitlements cannot be generated at the same time. Selecting an entitlement in one license area causes the other license area to become inactive for the remainder of the license generation session.

For design tools, available seats represents the number of seats available for licensing over the total number of seats purchased. For IP, seats are managed according to the terms of the site wide license agreement.

Products with a status of Current are within their warranty period. Products with a status of Expired have a warranty period end date that has passed. If seats are available, licenses can be generated for either Current or Expired product entitlements.

The Vivado Design Suite: 30-Day System Edition evaluation product entitlement provides access to all the capabilities in the Vivado Design Tools. This product entitlement is automatically included in your product licensing account.

Product vouchers for design tools and IP product licenses can be shipped with a Xilinx or partner development board or design kit. If you have a product voucher card, you can enter the voucher code on the card into the associated text field and click Redeem Now. This places the corresponding design tools or IP product entitlement in the product entitlement table which you can use to generate a license key.

To add Evaluation and No Charge IP to the list of product entitlements, click the **Search Now** button in the Add Evaluation and No Charge IP Cores section of the page. This opens an IP product finder tool.
Chapter 5: Obtaining and Managing a License

Managing Licenses on the Xilinx Product Licensing Site

The Xilinx Product Licensing Site tracks the licenses that you have generated. Select the Manage Licenses tab to see all licenses generated in your product licensing account.

Figure 5-17: IP Product Selector
Chapter 5: Obtaining and Managing a License

Use the Manage Licenses page to perform the actions described below.

Exploring and Retrieving Your Existing Licenses

Information regarding the licenses in your product licensing account are displayed in a split-section view. Click a row in the master view in the top table, to see detailed information about the licenses in the detail view in the bottom table. The detail view table displays:

- A list of product entitlements enabled by file.
- Comments associated with the file.

The detail view table gives you the ability to:

- Download - If your license or activation fulfillment file does not arrive through email you can download it here.
- Email - Have the license or activation fulfillment file emailed to you or another user.
- View - Gives you the ability to view the actual license file.
Chapter 5: Obtaining and Managing a License

- Delete (Certificate-based Licenses only) - Delete the license file. After a file is deleted
  the entitlement will then become available on the Create New License page and can be
  regenerated for another host ID.

- View the end user license agreement (IP only).

Modifying Licenses

Activation-based licenses cannot be modified on the Xilinx Product Licensing Site. To
modify an activation-based license, first use the Return License to Xilinx page in the Vivado
License Manager or create a return request in the appropriate command-line license
manager. After you return an activation-based license, you will see that the entitlement
count on the Xilinx Product Licensing Site’s Create New Licenses tab has been incremented
by the number of seats you have returned. A new activation-based license can now be
generated for a different machine, for the same machine with more seats, different features,
or other changes.

To modify an existing certificated-based license, select the license file in the master view.
You can modify a certificated-based license as follows:

Delete Entire License File and Place Entitlement Back into Your Account

1. From the Manage Licenses Tab (see Figure 5-18), select the license file you wish to
delete.

2. Click the Delete button located below and to the left of the license file details.

3. Click the Accept button to accept the Affidavit of Destruction.

Note: This will delete all license seats in the entire license file and return the entitlements to your
account.

Rehost: Change the Node-Locked or License Server Host ID for a License File

1. From the Manage Licenses Tab (see Figure 5-18), select the license file you wish to
rehost.

2. Click the Modify License button. The Modify License screen appears.

3. Go to System Information.

4. Change or add new Host ID and/or Host Name by using the drop-down list and text entry
   boxes respectively.

5. Click the Next button twice and then click Accept to accept the Affidavit of Destruction.

Add Additional Seats to an Existing Licensed Product Entitlement

1. From the Manage Licenses Tab (see Figure 5-18), select the license file to which you
wish to add seats.
Chapter 5: Obtaining and Managing a License

2. Click the **Modify License** button. The Modify License screen appears.

3. Go to **Product Selection**.

4. For floating licenses, you will be able to change the Requested Seats field and add seats up to the total number of seats available in your entitlement.

5. Click **Next** twice. No Affidavit of Destruction is required for adding seats.

**Remove Seats From an Existing Licensed Product Entitlement**

1. From the Manage Licenses Tab (see Figure 5-18), select the license file from which you wish to remove seats.

2. Click the **Modify License** button. The Modify License screen appears.

3. Go to **Product Selection**.

4. For floating licenses, you will be able to change the Requested Seats field and reduce the number of seats that will be authorized by this license file.

5. Click the **Next** button twice and then click **Accept** to accept the Affidavit of Destruction.

**Add Additional Product Entitlements to a License Key File**

1. From the Manage Licenses Tab (see Figure 5-18), select the license file to which you wish to add features/entitlements.

2. Click the **Modify License** button. The Modify License screen appears.

3. Go to **Product Selection**.

4. Check boxes of any new entitlements you wish to add to this license file.

5. Click **Next** twice. No Affidavit of Destruction is required for adding features.

**Delete Product Entitlements From a License Key File**

1. From the Manage Licenses Tab (see Figure 5-18), select the license file to which you wish to delete features/entitlements.

2. Click the **Modify License** button. The Modify License screen appears.

3. Go to **Product Selection**.

4. Check boxes of any entitlements you wish to remove from this license file.

5. Click the **Next** button twice and then click **Accept** to accept the Affidavit of Destruction.

Modifying a key file uses the same input form as when the license key file was created, except that additional product entitlements of the same license type (floating or node-locked) are made available for adding to the license file.
Chapter 5: Obtaining and Managing a License

If, during any of the modification steps, you receive a message that you have exceeded your number of rehost attempts, email cs_1@xilinx.com to request additional rehost options.

Reclaiming Deleted License Components

A product entitlement is deleted when one of the following occurs:

- Changing the license server host for a license key file.
- Removing seats from an existing licensed product entitlement.
- Deleting product entitlements from a license key file.

When you delete seats or remove products from your certificate-based license files, the entitlement is essentially “put back” or reallocated into your licensing account. You will find that the number of entitled seats in the Create New Licenses tab of your account is incremented by the same number of seats you deleted previously from existing license files.

Before the reallocation of entitlement occurs, you must first agree to an Affidavit of Destruction. This legal agreement is required to ensure the deactivated product entitlements are no longer being used.

The number of allocation operations is recorded for each user. Administrators are allowed to reallocate product entitlements five times per major release. End users are allowed to reallocate product entitlements three times per major release.

What Happens to Your License Key File

Each time a license is generated for a product entitlement, a FLEXnet increment line and corresponding package line is added to the license key file. When a license key file is modified to add seats for an existing or new product entitlement, additional increment or package lines are added to the license key file.

When a license key file is rehosted or is modified to delete seats or product entitlements, the corresponding increment lines are regenerated or removed from the modified license key file.

Legacy Licensing

If you wish to obtain a license for Releases 10.1 or earlier, click the Legacy Licensing tab.
Chapter 5: Obtaining and Managing a License

Then complete the following steps for the respective versions:

10.1 and Prior Versions

1. Select the version you desire. You will be prompted to verify your contact information.
2. Fill out the requested form with the required information to receive your registration IDs. Your registration ID will be displayed on the screen and emailed for your records.
3. Go to the Xilinx download center, click the Archive link under the Version column on the left side of the page to select the product you desire.
4. During the download process you are prompted to insert your registration ID to complete the download process.

Your Licensing Account

Product Licensing Accounts

When you purchase a design tool edition or IP product from Xilinx, you are purchasing a license to use and receive updates for that product for one year. The license to use Xilinx design tools and IP products is managed through the use of product entitlements. A product entitlement is the determination of:

- Which product was purchased
- The number of seats purchased
- The license type (certificate or activation-based, floating or node-locked)
- The product subscription period (product updates are provided throughout the year)

In addition to managing the product entitlements for your purchased design tools and IP, you can also access product entitlements for No Charge or Evaluation products. Full and No
Charge licenses have a subscription period of one year. Design tools evaluations are for 30 days, and IP evaluations are for 120 days.

Generating a license from a product entitlement results in one or more license keys being generated by the website. When installed, the license keys enable the use of the design tools and IP that were purchased or are being evaluated. Your product entitlements and resulting license key files are managed in a product licensing account on the Xilinx website.

Product licensing accounts are specific to the individual listed on the Xilinx Software Purchase Order, who is either the end user or administrator of the design tools. All purchases made can be managed in the same product licensing account if a single administrator is named. A company site can have multiple accounts managed by different administrators. The latter is helpful if a site has multiple design teams working on differing projects with different budget pools.

Note: A license can be generated for a product entitlement that has expired; however, it only enables product releases up to the subscription end date. Applying a product update made available after the subscription end date of your license will result in a licensing error the next time the tool is used.

LogiCORE IP License Generation in the Xilinx Design Tools

Any LogiCORE™ IP and design tools entitlements you have purchased appear in your list of entitled products when you log into the Product Licensing Site. Currently, all IP entitlements will generate certificate-based licenses. Licenses for Evaluation and No Charge IP are available on the site in a separate area. Licenses for all your certificate-based design tools and IP can now be generated in one pass. They are emailed to you in a single license file.

User Types and Actions

There are three user types for the Product Licensing Site: customer account administrator, end user, and no-charge user.

Customer Account Administrator

An example of a typical customer account administrator is a CAD tools manager. Every product licensing account must have at least one customer account administrator. A customer account administrator can manage more than one product licensing account.

The responsibilities as the customer account administrator include:

- Generating node-locked or floating licenses for Xilinx design tools and IP products.
- Adding and removing users from the product licensing account.
- Assigning administrative privileges to other users.
- Ordering product DVDs (if desired).
Chapter 5: Obtaining and Managing a License

The original customer account administrator is the Ship To contact identified during the product ordering process. That person receives an email with instructions on how to download and license each purchased product. The customer account administrator must follow the link in the email, to ensure access to the purchased products.

**End User**

Adding end users to a product licensing account allows an engineer or design team member the flexibility to manage and generate license keys on their own. The end user can generate license keys for node-locked products entitlements within the account as well as evaluation and “no charge” license keys for design tools and IP products. A customer account administrator can also configure the end user account to allow an end user to generate floating licenses. An end user cannot:

- View or generate floating license keys by default. This privilege can be assigned to them by the customer account administrator.
- View the license keys generated by other users.
- Add or remove other users to or from the product licensing account.

**No-Charge User**

No-Charge users can:

- Generate a 30-day free evaluation license key that enables Vivado System Edition.
- Generate a 30-day free evaluation license that enables Vivado HLS.
- Generate license keys for evaluation and no charge IP products.
- Generate a WebPACK™ tool license that enables WebPACK features in both ISE and Vivado.
- Request a Xilinx Design Tools DVD package with one of the following shipping options:
  - Free Shipping (2-4 Weeks)
  - Standard (2-3 Days)
  - Overnight

All user types can download products electronically and request a Xilinx Design Tools DVD.

**Note:** A customer who is already licensed for a full version of a Xilinx Design Tools product edition can evaluate other Xilinx Design Tools product editions or IP. These product entitlements are made available in the same product licensing account.
Changing Xilinx User Account Information

**IMPORTANT:** It is important to keep your Xilinx User Account up to date. As you change companies, addresses or emails might change.

### Modifying Your Corporate Email Address

2. Click **Sign In**.
3. Expand **Personal Information**.
4. Enter your new corporate email address in the **Enter new Corporate email address** box.
5. Click **Save Profile** button for changes to take effect.

### Understanding Your Tool and IP Orders

The Orders tab will display information regarding the purchasing orders that created the entitlements you see in this account.
Chapter 5: Obtaining and Managing a License

- Xilinx order numbers are listed on the left panel of the screen.
- Order details populate on the right panel of the screen when you highlight specific order.
- You might only select one order at a time.

Figure 5-20: Orders
Chapter 5: Obtaining and Managing a License

Managing User Access to Product Licensing Account

The responsibility of administering a product licensing account can be transferred or shared with another user. The ability to add or remove users from a product licensing account is managed under the Manage Users tab.

Adding Users

To add a user to your product licensing account:

- Type in the corporate email address of the new user.
- Check Add as a full administrator, to grant the new user customer account administrative privileges. Check Allow Floating Licenses, to grant the new user the ability to generate Floating Licenses, but not have full administrative privileges.

Note: The email address you provide must be the same email address the user supplied or supplies when creating their Xilinx account. If not, you might not be properly recognized when logging in.

If added users have already logged into the Product Licensing Site, their name appears in the user list. If they have never been to the site, the words Not Yet Registered appears in the space for their name. After they registered, their name is filled in.
In some instances, a customer account administrator might wish to have design team members administer license key files for their own use. By leaving both Add as full administrator and Allow Floating Licenses check boxes unchecked, you grant the user the following restricted privileges:

- User can generate node-locked license keys only.
- User can view and modify only those license key files they generated for themselves.
- User cannot manage users.

If you check Allow Floating Licenses only, the restriction on node-locked keys is lifted, but the others remain. You cannot check both boxes because it is not allowed. Full administrators already have floating license generation capability.

**Removing Users**

To remove administrative or floating license generation privileges from a user, uncheck the Administrator or Floating check box for that user.

To remove a user from a product licensing account, click the Delete button for that user.
Chapter 6

Older Release Notes

Release Notes 2016.3

What’s New

Vivado® Design Suite 2016.3 introduces the following Device Support and Vivado System Edition Products.

Device Support

The following UltraScale+ devices are introduced in this release.

- Kintex UltraScale+:
  - XCKU3P, XCKU5P, and XCKU15P
- Zynq UltraScale+ MPSoC:
  - XCZU7EV, XCZU17EG, and XCZU19EG

The following 7 Series devices are introduced in this release.

- Single Core Zynq-7000 Devices:
  - XC7Z007S, XC7Z012S, and XC7Z014S

Vivado System Edition Product

Vivado High Level Synthesis

- Register AXI4-Stream adapters for better system performance.
- New Mechanism to preserve port names across different compilations.
- Designer assistance for CoSimulation.
- Enhanced information for failed schedules.
- Compare 'Export' reports in GUI.
- Dataflow graphical viewer introduced.
Vivado Design Suite 2016.4 Release Notes

Chapter 6: Older Release Notes

- Reworked “Export RTL” with option to only evaluate up to RTL synthesis.

**System Generator for DSP**

- Enhancements to FFT/IFFT: Optional Start Frame Ports make it easier to align and synchronize frames at the input and output of these blocks.
- UltraRAMs Support: Dual-port and Single-port RAM Memory blocks enhanced to allow implementation of blocks in UltraRAM Memory for UltraScale architecture-based devices.

**Vivado Design Edition Tools**

**General**

- Support for IEEE 1735-2014 based encryption enabled that allows sharing IPs in a secure and easy way.
- Support for non-processor based Memory initialization via XPM_MEMORY.

**Integrated Design Environment**

- Text Editor Improvements.
  - Comment folding.
  - Goto definition and find function usage.
  - Highlight words with double-click.
- Grouping of runs with status rolled up at grouped nodes.
- Microsoft Excel-like Column filtering in tables.
- Clock Utilization report and Incremental Reuse reports available in IDE.

**Power Analysis and Xilinx Power Estimator (XPE)**

- Vivado report_power now supports the Zynq UltraScale+ EV family with the Video Code Unit (VCU).
- Improved VCU support in XPE, adding separate configuration of Encoder and Decoder for greater accuracy.
- Off-Chip power is now supported for UltraScale and UltraScale+ devices on the XPE IO sheet.
• Default Routing Complexity value in XPE is now 10 for UltraScale+, for better accuracy of estimating routing interconnect power.

• XPE Clock sheets now have a Fanout/Site setting resulting in improved clock power accuracy when importing routed results from Vivado.

• Total Power is now displayed as a sortable column in the Design Runs and is available as a design runs property STATS.TOTAL_POWER. This enables easy sorting of design runs by their total power.

• Vivado report_power has incorporated two visual indications already supported by XPE:
  - Supply current is highlighted in blue if the startup current exceeds steady-state current.
  - A Critical Warning occurs and power and current are highlighted in red when current exceeds the maximum supported by the package.

• New XDC constraints have been introduced to globally control switching activity on reset-type control set signals.
  - set_switching_activity -deassert_resets: this assigns switching activity such that resets are deasserted, resulting in more realistic activity throughout the design.
  - reset_switching_activity -no_deassert_resets: this undoes the effects of set_switching_activity -deassert_resets.

  Note: The deassert constraint is set automatically when running report_power interactively in the IDE.

**Vivado IP Integrator**

• Designer Assistance for 10G/25G Ethernet Subsystem.
• Default IP caching and OOC (Out of Context) mode during RTL synthesis.
• AXI SmartConnect.
  - Reduced runtime and disk footprint.
• AXI interface-level debug capability with Vivado Debug.

**Vivado IP Catalog**

• Support for IEEE 1735-2014 based encryption enabled that allows sharing IPs in a secure and easy way.

**Simulation Flows**

• IP and XPM Libraries are compiled in conjunction with Unisims/Simpris to reduce additional compile time during simulation.
• Simulation scripts leverage compiled IP libraries to save disc space and to decrease compile time.

**Vivado Simulator**

• Incremental compilation support is added to reduce compilation time.
• IP and XPMs libraries are now pre-compiled and delivered with tools to save time.
• Simulator GUI settings are preserved from run to run.
  ° Radix, time-unit, trace limit & array display limit settings are saved globally as a user preference.
  ° Size, position, column arrangement, filter buttons of Scope and Object window are saved per project.

**RTL Synthesis**

• VHDL-2008 Fixed point support enabled.
• Clock gating enhancements.

**Implementation**

• New and updated *place_design* directives:
  ° *EarlyBlockPlacement* which locks down block RAM and DSP block locations early in the flow, then uses those blocks to anchor placement of remaining logic. Useful variation for designs with many RAM and DSP blocks.
  ° *AltSpreadLogic_low*, *AltSpreadLogic_medium*, and *AltSpreadLogic_high*: Updated to improve routability for designs with routing congestion.
  ° *SSI_BalanceSLRs*: Updated for better overall partitioning quality when targeting SSI devices.
• Logic Optimization: *opt_design* now has new optimization phases and options:
  ° *-bufg_opt*: all optimizations involving insertion and removal of global clock buffers (included by default).
  ° *-control_set_merge*: Merge logically equivalent control signal drivers to enable them to be more optimally replicated further downstream.
  ° *-hier_fanout_limit <limit>*: Replicate high fanout net drivers according to logical hierarchy.
• Path groups defined by XDC *group_path* are supported by *phys_opt_design* and *route_design*. This allows certain paths to be grouped and prioritized over other paths for more focused timing closure.
**Static Timing Analysis**

- Timing Constraint Wizard support for setting bus skew.
- Support for renaming clocks.
- Ability to convert phase shift to delays on MMCM/PLLs.
- Additional clocking methodology checks added.

**Vivado I/O Planner**

- Improved memory interface placer in the Byte planner.

**Vivado Debug**

- AXI interface-level debug capability for IP Integrator designs.
- Support to remotely debug FPGA/SoC via Ethernet.
- Support to debug designs with Tandem with field updates.
- Trigger/Capture setting improvement.
  - Create user defined probes in IDE.
  - Intuitive methods to change probe values in trigger setup window.
- Serial I/O Analyzer
  - In-System IBERT: Utilize user-data to plot eye-scan.
  - Enhanced eye-scan plotting.

**Hierarchical Design Flows**

- Project mode support for Partial Reconfiguration designs
  - RTL and netlist projects managed within the Vivado IDE
- Beta support for UltraScale+ devices for Partial Reconfiguration or Tandem Configuration
  - Tandem Configuration for 5 UltraScale+ devices: ZU19EG, KU15P, VU3P, VU7P, and VU9P.
  - Beta support enables PCIe IP generation and implementation, but does not enable bitstream generation.
Chapter 6: Older Release Notes

- Expanded tutorials in the Vivado Design Suite Tutorial: Partial Reconfiguration (UG97) [Ref 7], as labs for project mode and the PR Controller IP for UltraScale devices have been added.

**Xilinx Parameterized Macro**

- New XPM FIFO
  - BlockRAM, UltraRAM, and Distributed RAM based
  - Synchronous and Asynchronous mode support
  - Programmable full and empty
  - Read and write data counts
- XPM Memory: ECC Support enabled

**intellectual Property (IP)**

- Simulation scripts leverage compiled IP libraries.

**Memory IP**

- Support for Zynq UltraScale+ MPSoC
- Efficient packing in byte-planner
- Clamshell support for DDR4 controllers
- ECC Support
- Ability to override MMCM M/D values in IDE
- HMC Controller IP added
- PCI Express Integrated Block for UltraScale+
  - Added Link Training Debug Tools: In-System Eye Scan, LTSSM Capture and more
  - Beta support for fast configuration of Tandem for selected devices
  - Added SR-IOV support: Up to 4 PFs and 252 VFs
- DMA Subsystem IP for PCI Express
  - Added support for Gen3 x16 in UltraScale+
  - Added support for Artix-7, Kintex-7, Virtex-7 (GTX devices), and Zynq 7000
  - Added shared logic support to allow for transceiver sharing

**Ethernet IP**

- All Ethernet now has optional GT out of the IP.
Chapter 6: Older Release Notes

• New 1000BASE-X/SGMII over LVDS asynchronous available on UltraScale and UltraScale+.

PCI Express Integrated Block for UltraScale+
• Added Link Training Debug Tools: In-System Eye Scan, LTSSM Capture and more.
• Beta support for fast configuration of Tandem for selected devices.
• Added SR-IOV support – Up to 4 PFs and 252 VFs.

DMA Subsystem IP for PCI Express
• Added support for Gen3 x16 in UltraScale+.
• Added support for Artix-7, Kintex-7, Virtex-7 (GTX devices), and Zynq 7000.
• Added shared logic support to allow for transceiver sharing.

Fibre Channel IP
• New 32G Fibre Channel Forward Error Correction.
  • Supports UltraScale and UltraScale+

Embedded IP
• New MicroBlaze 8-stage pipeline, optimized for higher frequencies.
• ACE port added to MicroBlaze for coherency with MPSoC caches.

Multimedia IP
• Video Test Pattern Generator
  • 8K resolution support and 8 pixels per clock option
  • DisplayPort related test patterns
  • Build time configurability allowing what test patterns to include
• Video Mixer
  • Per pixel alpha for memory layers and logo layer.
  • 4:2:0 support.
  • 10 bit RGBX and YUVX 444.
  • YUV422 and YUV420 8 bit semi-planar memory formats to support VCU.
• VPSS (Updates to Scaler only version)
  • Adds 4:2:0 support.
Chapter 6: Older Release Notes

- Adds Optional Color Space Conversion and Chroma resampling to allow format conversion in scaler configuration.

  HDMI
  - Integrated reference design Vivado release. It is now available as a Vivado Example Design. Supports KC705, KCU105 and ZC706 Boards.
  - Added a HPD toggle function to the HDMI TX core. This update was required to solve an issue related to HDCP compliance testing.
  - Added HDCP auto-switching between 1.4 and 2.2.
  - Added HDCP repeater mode support.
  - Added HPD and Cable Detect polarity control in GUI.

  MIPI
  - New IP for implementing MIPI CSI TX Subsystem, supporting 7 series and UltraScale+ devices.
  - Added 7 series support to MIPI CSI RX subsystem and MIP DSI TX subsystem.
  - Added 7 series support to MIPI D-PHY.
  - Linux driver for MIPI CSI RX subsystem.

Processor Configuration Wizard

- New re-designed DDR Configuration Page
- New Isolation configuration page
- Intuitive clock configuration page

Xilinx Software Development Kit

- For release notes information on the Xilinx Software Development Kit (SDK) see Answer Record 66230

Important Information

Device Support

IMPORTANT: When opening a checkpoint targeting UltraScale+ Production Evaluation parts, Vivado will issue the following warning:

Production Evaluation speedfiles are provided in advance of production release and are intended to closely approximate production level performance. Once production speedfiles become available, the design will need to be rerun with the production speedfiles.
Simulation

Export Simulation (export_simulation)

Multiple switches have been deprecated in this release.

Table 6-1: Deprecated Switches

<table>
<thead>
<tr>
<th>Switch Name</th>
<th>Default Behavior</th>
<th>User Action</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>-ip_netlist</td>
<td>False</td>
<td>None</td>
<td>Fastest simulation is available only in pure RTL. Export simulation optimized to write scripts for fastest simulation performance.</td>
</tr>
<tr>
<td>-language</td>
<td>Mixed</td>
<td>Mixed language simulator required</td>
<td>In order to ensure the fastest simulation performance, export simulation will only use the language of the IP RTL</td>
</tr>
<tr>
<td>-single_step</td>
<td>• True for Cadence IES • False for others</td>
<td>Be aware of this change</td>
<td>Cadence IES simulation will deliver irun scripts that can handle mixed language RTL simulation. Using single-step for the other simulators requires gate level simulation netlist.</td>
</tr>
</tbody>
</table>

Integrated Simulation (launch_simulation)

• Starting in Vivado 2016.1, the Generate Scripts Only capability has been deprecated and removed from the IDE.

• User should use the Export Simulation capability instead. This provides the functionality for exporting files from Vivado (IP and IP Integrator) to use in external verification environments.

Vivado Design Suite Documentation Update

In the 2016.3 Vivado Design Suite Documentation release, not all documentation will be available at first customer ship. Use the Update Catalog button in DocNav to stay up-to-date with the 2016.3 documentation suite.

Note: DocNav is a 32-bit application and requires the installation of 32-bit libraries on Linux in order to function.

Known Issues

Vivado® Design Suite Tools Known Issues can be found at Answer Record 66830.
Release Notes 2016.2

What’s New


Get Vivado Design Suite 2016.2 with support for Virtex® UltraScale+™ and Defense-Grade Kintex® UltraScale™ devices.

Device Support

The following UltraScale+ devices are introduced in this release.

• Virtex UltraScale+ devices: XCVU3P, XCVU5P, XCVU7P, XCVU9P

The following UltraScale devices are introduced in this release.

• Defense-Grade Kintex UltraScale FPGAs: XQKU040, XQKU060, XQKU095, XQKU115

Vivado Design Edition Tools

Power

• Xilinx Power Estimator (XPE) for UltraScale+:
  • Support for the D2104 package with following part-package combinations: XCVU9P-FSGD2104, XCVU11P-FSGD2104, and XCVU13P-FIGD2104.
  • VCCINT current check for Virtex UltraScale+ devices: Checks if VCCINT supply current exceeds the maximum supported by the package. If maximum is exceeded, then the current is highlighted in red to alert the user.

• Xilinx Power Estimator (XPE) for UltraScale and Vivado Report Power introduce support for new Kintex UltraScale Defense parts:
  • Military (-1M) speed grade for Kintex UltraScale Defense parts XQKU040, XQKU060, and XQKU095.
  • XQKU115 devices

Intellectual Property (IP)

• GT in example design
  • AXI Ethernet and 10G/25G Ethernet Subsystem enabled
Chapter 6: Older Release Notes

- Allows you to manage the transceiver settings within the GT wizard GUI (safest way to tune transceivers).
- Safely edit transceiver settings with the ability to upgrade the core and/or the transceiver without losing your tuned settings.
- Makes it easier to share a transceiver with other cores since the transceiver is outside the core.

Important Information

Device Support

**IMPORTANT:** When opening a checkpoint targeting UltraScale+ Production Evaluation parts, Vivado will issue the following warning:

*Production Evaluation speedfiles are provided in advance of production release and are intended to closely approximate production level performance. Once production speedfiles become available, the design will need to be rerun with the production speedfiles.*

Simulation

*Export Simulation (export_simulation)*

Multiple switches have been deprecated in this release.

<table>
<thead>
<tr>
<th>Switch Name</th>
<th>Default Behavior</th>
<th>User Action</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>-ip_netlist</td>
<td>False</td>
<td>None</td>
<td>Fastest simulation is available only in pure RTL. Export simulation optimized to write scripts for fastest simulation performance.</td>
</tr>
<tr>
<td>-language</td>
<td>Mixed</td>
<td>Mixed language simulator required</td>
<td>In order to ensure the fastest simulation performance, export simulation will only use the language of the IP RTL</td>
</tr>
<tr>
<td>-single_step</td>
<td>• True for Cadence IES • False for others</td>
<td>Be aware of this change</td>
<td>Cadence IES simulation will deliver irun scripts that can handle mixed language RTL simulation. Using single-step for the other simulators requires gate level simulation netlist.</td>
</tr>
</tbody>
</table>

*Integrated Simulation (launch_simulation)*

- Starting in Vivado 2016.1, the **Generate Scripts Only** capability has been deprecated and removed from the IDE.
• User should use the Export Simulation capability instead. This provides the functionality for exporting files from Vivado (IP and IP Integrator) to use in external verification environments.

Vivado Design Suite Documentation Update

In the 2016.2 Vivado Design Suite Documentation release, not all documentation will be available at first customer ship. Use the Update Catalog button in DocNav to stay up-to-date with the 2016.2 documentation suite.

Note: DocNav is a 32-bit application and requires the installation of 32-bit libraries on Linux in order to function.

Known Issues

Vivado® Design Suite Tools Known Issues can be found at Answer Record 66830.

Release Notes 2016.1

What’s New

The Vivado® Design Suite HLx Editions version 2016.1 delivers over 10% better quality of results for UltraScale™ devices and extends SmartConnect technology for the UltraScale+™ portfolio of devices. These SmartConnect extensions solve system interconnect bottlenecks on high density, multi-million logic cell designs. As a result, UltraScale+ devices, shipping now deliver a 14% performance advantage and a full speed-grade over the announced competing 14nm FinFET technology.

The Xilinx SmartConnect technology extensions enabling this performance breakthrough include:

• Time borrowing and useful skew optimization techniques, enabled by the new UltraScale+ fine-grained leaf clock delay insertion capability. This capability enables higher clock frequencies by moving clock capture edges, shifting available timing slack to performance critical paths.

• Pipeline analysis and re-timing allows designers to further increase performance, specifically the clock frequency, by adding extra pipeline stages in the design and applying automatic register re-timing optimization.

• AXI SmartConnect IP, a new system connectivity for AXI-based IP and peripherals which synthesizes a custom connectivity network during IP integration, thereby achieving higher system bandwidth than a crossbar interconnect, at a smaller area footprint. The AXI SmartConnect IP is available in Early Access via Vivado IP Integrator in the 2016.1 release of the Vivado Design Suite.
Use Vivado WebPACK Without a License File

In the past, Vivado WebPACK required a free FLEX license before it could be used. Beginning in 2016.1, customers targeting WebPACK devices no longer need this license file. Also, in 2016.1, Vivado Debug IP is included with WebPACK and also no longer requires a FLEX license file.

Device Support

The following new devices are enabled for this release.

<table>
<thead>
<tr>
<th>Table 6-3: Vivado 2016.1 Device Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Production Level</td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td>New Devices</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>General Access</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Bitstream Generation</td>
</tr>
</tbody>
</table>

License

Customers who renew their Vivado subscription beginning with the 2016.1 release will receive traditional, certificate-based license files (.lic) instead of activation-based entitlements. Customers who still wish to receive activation-based licenses should contact Xilinx Development System Customer Service.

Language Templates

The Vivado language templates have been enhanced this release. The templates are available from the startup screen without the need to have a project open.

Report UltraFast Methodology Checks

A new Report Methodology command has been enabled in this release. You now have the ability to run methodology checks in the synthesized and implemented design views that are also available when the elaborated design is open.
This new command replaces the existing Report DRC with the methodology ruledeck capability.

**Vivado Quick Help**

- Access help directly from the tool:
  - Dockable windows
  - Dialog boxes
  - Wizards
- Links to DocNav and on-line videos.
- New content will be added each release.

**Vivado High-Level Design Edition Tools**

**Vivado HLS**

- Previous device architectures only available in ISE can no longer be targeted from this newest version of Vivado HLS. They require an older version of Vivado HLS and continue to be supported.
- Tuning for improved timing estimates.
- When launching the Vivado waveform viewer (after a C/RTL co-simulation), the waveforms are now conveniently grouped as design input and output as well as block-level I/Os.
- New resource core option XPM_MEMORY to leverage the new memory generator. It allows targeting the UltraRAM offered in the UltraScale+ architecture.

**RTL Synthesis**

- Global re-timing (register balancing) to improve design performance.
- VHDL-2008 enabled by default, source files simply need to have their type set to that language option.
- Assert global synthesis option to compute VHDL static checks at elaboration.
- Global shift register LUT (SRL) cell extraction option to turn off their inference. Useful for designs with high utilization of LUT RAM to free up resources and potentially achieve better performance.
- Synthesis options to control the number of cascaded blocks for inferred RAM (applicable to block RAM and UltraRAM blocks in UltraScale and UltraScale+ architectures).
Chapter 6: Older Release Notes

- New non timing driven global option to run synthesis without taking timing into account while keeping XDC files unchanged (useful to baseline area and performance with Vivado RTL synthesis).

**Partial Reconfiguration**

- UltraScale device support is complete. Kintex UltraScale KU025 has been added, and the Virtex UltraScale VU440 is available upon request.

- The Vivado Design Suite Tutorial: Partial Reconfiguration (UG947) [Ref 7] has two new additional labs.

  1. The base tutorial design is now available for UltraScale, targeting the KCU105.

  2. A design example shows the PR Controller IP used for a design targeting the KC705.

- Reconfigurable Module checkpoints now capture interface routes. This allows users to mix and match modules from different Reconfigurable Partitions to create any full configuration without the need to stitch them together using `route_design`.

- Partial bitstreams for 7 series and Zynq designs automatically embed blanking commands to guarantee static glitching can never occur.

- The Partial Reconfiguration Decoupler IP has been given production status.

- For more information, see this link in the Vivado Design Suite User Guide: Partial Reconfiguration (UG909) [Ref 6].

**Tandem Configuration**

- UltraScale device support is complete with the addition of KU025 and VU440.

- Tandem with Field Updates has been released for all UltraScale devices. This solution combines the two-stage fast configuration of Tandem PROM or Tandem PCIe with the ability to update the entire user application (everything but the PCIe IP) via Partial Reconfiguration.

  - A pre-defined design structure, floorplan, and compilation scripts are delivered with the IP Example Design.

  - A new Debug Bridge IP is available to enable debug capabilities within the reconfigurable Update Region. For this release, this IP is only supported for the Field Updates use case.

  - Tandem Configuration and Partial Reconfiguration are supported in the same UltraScale design in general, and a PR license is needed for all but the Field Updates use case.

- All variations of Tandem Configuration (including Field Updates) and Partial Reconfiguration over PCIe have been added to both the AXI Bridge for PCI Express IP and the DMA Subsystem for PCI Express IP.
• For more information on Tandem Configuration, see the UltraScale Architecture Gen3 Integrated Block for PCI Express Product Guide (PG156).

**Vivado Physical Implementation**

• Core placement and routing algorithms increase Fmax by 10-11% on average, with notable improvements in the following areas:
  - Placement for SSI devices, in particular:
    - Routing congestion reduction.
    - Partitioning of logic into SLRs to minimize SLR crossings and to avoid critical paths that cross SLRs.
    - Replicating critical path logic that drives both within SLRs and across SLRs.
  - Balanced spacing of pipeline registers used for traversing long distances at high speeds.
  - Introduction of algorithms for optimal placement of global clock buffers driven by fabric logic resources.
  - Hold-fix routing and setup vs. hold balancing.
• The Vivado Router now creates useful skew by fine-tuning the programmable UltraScale+ clock leaf drivers to increase setup and hold slacks and improve Fmax by an extra 3-4% on average.
• Placer directives and Implementation Strategies have been updated to ensure they continue to provide performance options across all device families. See the Vivado Design Suite User Guide: Implementation (UG904) [Ref 10] for further information.
• The CLOCK_BUFFER_TYPE property now supports the values of BUFG and BUFGCE to enable global buffer insertion using XDC constraints. The buffer insertion occurs in opt_design. This provides the advantage of inserting global buffers without modifying the design sources or netlists.
• Physical optimization (phys_opt_design) has introduced a new optimization phase called Critical Path Optimization. This is run as the last phase of physical optimization when using the Explore directive. Physical optimizations are run on the top failing critical paths of all endpoint clock groups regardless of criticality to reduce per-clock group WNS.
• Physical optimization reporting: After phys_opt_design has run, the new reporting command report_phys_opt provides complete details of each physical optimization at the netlist level, showing how phys_opt_design was able to improve design performance. Additionally phys_opt_design provides a table summary in the log file showing the timing impact of each optimization phase. This can be useful for running successive iterations of phys_opt_design with subsequent focus on optimizations that are the most effective.
The reporting command `report_clock_utilization` has been significantly overhauled to ensure consistent reporting of different clock resources and to provide more information about the related clocks and detailed information needed to analyze usage of the more flexible UltraScale and UltraScale+ clocking architectures.

### Vivado Power Tools

- A new Power Constraints Advisor is available to help identify and correct switching activity used for power analysis, reducing the likelihood that power is under-reported due to large, undetected regions of zero or extremely low activity. Launched from the Tools Menu, the Power Constraints Advisor is invaluable in searching through massive amounts of logical objects to highlight the ones whose suspicious switching activities have the highest impact on power accuracy.

- New XPE (Xilinx Power Estimator) features and enhancements for improved estimation quality and greater ease-of-use:
  - UltraRam (URAM) Sheet: Improved model and UI with new columns that align closer to design entry: Latency, Data Width, and separate Input and Output Toggle Rates.
  - URAM and block RAM Sheets: Write Rate has been replaced by Write Enable. Write Enable represents the percentage of time a block RAM is being written whereas Write Rate represented a percentage of Enable Rate for writing. Overall this makes specification more intuitive and consistent with Vivado Report Power. Automatic conversion occurs when importing XPE files generated before 2016.1.
  - PS Sheet: Significant ease-of-use improvements with better overall organization by Power Domains and addition of missing power rails.
  - GT Sheets, Channels Sharing QPLL: Improved accuracy for partially-used quads.
  - Importing from Vivado `report_power`, Logic Sheet: The Logic is grouped by clock domain with labels matching Vivado clock names and matching clock frequencies instead of signal rates. This enables easy identification of the clock domain associated with the imported logic.

- Vivado Power Analysis (`report_power`) runtime has improved dramatically, an average of 33% faster on post-route designs.

- Power Reports can be saved and opened in the Vivado IDE. When an implemented design run is opened, the saved graphical power report is automatically restored. This saves additional runtime as it is no longer necessary to rerun `report_power` to generate the graphical report.

- Power Optimization is now enabled for UltraScale+ devices which can help reduce overall power. Actual power reduction is design-dependent. For more details on Power Optimization see the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) [Ref 11].
**PS Power Reports**

- **Signal Power Accuracy:**
  - Vivado `report_power` includes significant improvements in signal power accuracy, resulting in much better correlation between `report_power` and XPE.
  - Signal power is tracked on the XPE Logic sheet using a new column **Routing Complexity** which indicates the average routing resources per logic cell. The default value is 8 and high complexity is 10. A value of 12 is very high, typically used for designs that experience routing congestion. When importing results from `report_power`, Routing Complexity is also imported based on the design's routing.

**Vivado IP Integrator - PCIe Designer Assistance**

- Support for XDMA with KCU105 hardware.
- Requires XDMA license.

**Vivado IP Integrator**

- HDL Module Reference Flow on by default
  - Easily add HDL to a BD without using the IP Packager
  - AXI Interfaces are automatically inferred
  - Source files can live outside of the project
  - Access via right-click in sources tree or on the canvas
- Support for 64 bit addressing (previously up to 63 bits was supported)
- ELF flow ease of use enhancements when packaging a BD
  - Now you can package a BD with a MicroBlaze or MicroBlaze MCS inside
- Improved caching of IP during BD synthesis
  - Reduced memory usage to determine a hit
  - Hit times reduced up to 100x (Less then 0.5-4.0 seconds in the 2016.1 release verses 45-60 seconds in the 2015.3 release.)
- Enhanced PCIe Designer Assistance for these boards:
  - Alpha-Data ADM-PCIE-7V3
  - Kintex UltraScale Alpha-Data board
  - Kintex UltraScale KCU105 Evaluation Platform
  - Virtex-7 VC709 Evaluation Platform
Chapter 6: Older Release Notes

- Virtex UltraScale VCU108 Evaluation Platform

**Vivado Simulator**

- Up to 3 times elaboration runtime performance improvement.
- Enhanced waveform debug experience.
  - Improved simulator relaunch feature.
    - Retains GUI, breakpoint, signal settings, and markers.

**Vivado Simulation Flow**

- Export Simulation:
  - Available in Managed IP and standard projects
  - Supports all the five simulator vendors
  - Provides simulation support for non-project users
  - Generates optimal simulation scripts as starting point
  - Incorporate easily into customer simulation environments
- Simulation scripts (for all vendors) authored as part of IP generation

**Vivado Debug**

- Debug Flow Enhancements:
  - Incremental Place and Route after post-synthesis ILA (re)insertion
    - Allows more debug turns per day while preserving the results (timing closure, placement)
    - Supported in both project & non-project modes
  - Replace signals connected to ILA probes within ECO GUI
    - Only allowed for a post-route checkpoint (.dcp)
    - Fastest way to make minor debug changes
    - Maximum level of design preservation
- Debug ILA Enhancements:
  - ILA support for more comparators
    - ILA core now supports up to 16 comparators per probe port
  - Manual creation of probes for ILA ports
    - Separate or re-group bits in concatenated probes
- Create probes mapped to physical probe ports, constant values, or a combination of both
- Get sample values of ILA probes with \texttt{list_hw_samples} Tcl command

\textbf{Debug Enhancements:}

- Runtime improvements
  - New trigger buttons added to Waveform window
  - Right-click and button in Waveform window to export ILA data
  - ILA data export with matching radices as shown in the waveform
- Support for multiple debug hubs in a design
- Memory calibration debug
  - LRDIMM interface support
  - Write margin analysis support for QDRIV and QDRII+
  - Descriptive warning messages for calibration stages

\textbf{Vivado Programmer}

- Ability to generate SVF (Serial Vector Format) files using Tcl.
- Capability to verify checksum of configuration memory devices.
- Improved robustness of HW connections.

\textbf{Programming Enhancements (AES and RSA Security Key)}

- eFuse programming dialog boxes supports both AES and RSA keys
- Supports 128 bit USER registers
- UltraScale control register support
- Battery Backed RAM (BBR) dialog box supports DPA Protect

\textbf{Programming Enhancements}

- Write Configuration Memory IDE Dialog
  - Available in the Hardware Manager and Vivado project
  - Option to generate Configuration memory after bitstream generation
- Serial Vector File Generation
  - Enhanced Tcl interface
  - Offline Board support
Chapter 6: Older Release Notes

- Support for 3rd party devices in chain
- Cable polling enabled
  - Unplug and re-plug in cable and re-connect back to the HW session

Vivado High-Level System Edition Tools

Vivado System Generator for DSP

- Board Awareness enables JTAG co-simulation on all boards in the Vivado tools, including user boards. When coupled with burst MCode co-simulation this provides a 45 times improvement in simulation time.
- Improved FFT extends the simplified DSP blocks available and includes modeling improvements to decrease simulation times.
- New resource analysis cross probing to the model helps identify hierarchies and blocks that may need improvements for utilization.
- For more details see the Vivado Design Suite User Guide: Model-Based DSP Design Using System Generator (UG897) [Ref 9].

VIPP

- DisplayPort Subsystems
  - Offers 2-byte and 4-byte interfaces to Video Phy.
  - Option to support native video input/output or AXI-S
  - HDCP 1.3 repeater mode
- HDMI Subsystems
  - Option to support native video input/output or AXI-S
  - Optional HDCP1.4 and/or HDCP2.2 encryption
  - 3D video support
- Video Processing subsystem
  - Additional configuration options, allowing users to implement deinterlacer only, scaler only, color space conversion only or chroma resampling only functions
  - Adds UltraScale+ support
- Video Mixer LogiCORE
  - New IP for mixing video layers, each layer can be up to 4K resolution
  - Supports 8 layer mixing plus on block RAM based logo insertion
- MIPI DSI tx subsystem
Chapter 6: Older Release Notes

- New IP for MIPI based display serial interface
- UltraScale+ device support

Video Phy
- Adds GTP support for Displayport and HDMI setting

Memory IP
- Dense memory support (128GB DIMMs)
  - LRDIMM and 3DS RDIMM for DDR4
- QDRIV added
- PingPong PHY added
- Samsung devices added
- DBI (Data Bus Invert) support which helps reduce power
- Self refresh and Save-Calibration (Save-Restore)
  - Useful to reduce calibration time
- ATG (Traffic Generator) selectable in the GUI
- New I/O planning features
  - DCI Cascade, half bank, diff_term support added

DisplayPort LogiCORE V6.1
- Addition of DP159 control to Displayport.

Ethernet IP
- 40G/50G Ethernet Subsystem
  - New switchable 40G/50G Ethernet
- MAC + BASE-R/KR/CR
  - 10G/25G Ethernet Subsystem
- New 25G Reed-Solomon Forward Error Correction (RS-FEC) optional feature
  - 50G RS-FEC
- New 50G Reed-Solomon Forward Error Correction (RS-FEC)

Text Editor Improvements
- Code folding (HDL)
- Collapse code based on language specific key words
- Real-time syntax checking (HDL)
  - Syntax checking occurs as you type
  - Errors are underlined
- Key word completion (HDL)
  - As you type, editor suggests completions
- Text editor settings moved to it's own Tools > Options section

Xilinx Parameterized Macros (XPM)
- A simple, lightweight, in-line customizable solution for most common HDL flow use cases
- Divided into libraries:
  - XPM_MEMORY and XPM_CDC
- User declares just top level XPM library
- Vivado will automate the rest
  - Provide synthesis and simulation support for XPMs
  - Handle associated files, for example, include files, mem init files

ECO Operations
- Post-implementation netlist changes
- ECOs enable
  - Small design changes with minimal perturbation to the design
  - Modifications to ILA probes
  - Fast turn-around times since place and route are incremental
- Available as a layout for checkpoints (DCPs)
- ECO GUI Features
  - ECO toolbar with controls for:
    - Netlist modifications
    - Incremental place and route
    - Reports
    - Output files
  - Scratchpad tracks the state of
Chapter 6: Older Release Notes

- Netlist connectivity
- Placement and routing

Static Timing Analysis (STA)

- New Clock methodology checks enabled in the `report_methodology` command
- Bus Skew Support
  - `set_bus_skew` - limit bus skew across asynchronous clocks domains
  - `report_bus_skew` - reports bus skew requirement across asynchronous clocks domains
- Timer Improvements
  - Speed-up when loading design checkpoints
  - Improved latch based timing analysis
  - Clock skew optimization (useful skew)

Important Information

Updates to Existing IP

The following table lists current updates to existing IP for the 2016.1 release.

<table>
<thead>
<tr>
<th>Existing IP</th>
<th>Existing IP Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCI Express®</td>
<td>• AXI-MM support for Gen3 PCI Express hard block (Virtex7 XT/HT).</td>
</tr>
<tr>
<td></td>
<td>• Tandem PCIe/PROM support (Beta) for UltraScale FPGA devices.</td>
</tr>
<tr>
<td></td>
<td>• Upgraded GT Wizard</td>
</tr>
<tr>
<td></td>
<td>• GUI options update to select PLL and Core Clocks</td>
</tr>
<tr>
<td></td>
<td>• Additional devices/packages supported for Tandem PCIe®</td>
</tr>
<tr>
<td>Aurora</td>
<td>• Extending line rate to 25G for UltraScale</td>
</tr>
<tr>
<td>IBERT for UltraScale</td>
<td>• An issue that may cause the under-reporting of errors has been fixed in all UltraScale IBERT cores.</td>
</tr>
<tr>
<td></td>
<td>• It is necessary for users who are performing very long tests or deep scans to re-generate the IP.</td>
</tr>
</tbody>
</table>
Chapter 6: Older Release Notes

Vivado Design Suite Documentation Update

In the 2016.1 Vivado Design Suite Documentation release not all documentation will be available at first customer ship. Use the Update Catalog button in DocNav to stay up-to-date with the 2016.1 documentation suite.

Installation

Beginning with the Vivado 2015.1 release, the install program on Linux no longer requires root or sudo privileges. In the past, these privileges were required to enable cable driver installation. Now, cable drivers must be installed manually by running a separate script while in a root/sudo command shell. For more information on Linux cable driver installation, see the Installing Cable Drivers section of this document.

Licensing

Activation licensing is not supported for USB dongles, on floating servers running SOLARIS OS, or on triple-redundant server configurations.

IP Known Issues and Change List

For Xilinx IP known issues, see the IP Release Notes Guide (XTP025) [Ref 12].

32-bit OS Support Removal

Beginning with Vivado 2015.1, 32-bit Operating System and application support has been removed for all design entry and implementation flows. The 32-bit support on Windows 7 and Red Hat Enterprise Linux 6 will remain for Vivado 2015.1 Lab Edition. Lab Edition is a free suite of tools for programming and debug.

Simulation

- **Export Simulation** \((\texttt{export\_simulation})\):  
  - In this release this command has been made into a true non-project based command as part of that, additional switches have been added.  
  - It is recommended that you use the Export Simulation Dialog GUI in order to identify the right set of switches and combinations to use.  
  - Multiple switches have been deprecated in this release.

- **Get Library Cells** \((\texttt{get\_lib\_cells})\):  
  - Tcl command will only return the true native primitives for a given device.  
  - Support for returning re-target components removed.
Chapter 6: Older Release Notes

Known Issues

Vivado® Design Suite Tools Known Issues can be found at Answer Record 66830.
Appendix A

Additional Resources and Legal Notices

Xilinx Resources
For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx Support.

Solution Centers
See the Xilinx Solution Centers for support on devices, software tools, and intellectual property at all stages of the design cycle. Topics include design assistance, advisories, and troubleshooting tips.

Documentation Navigator and Design Hubs
Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support resources, which you can filter and search to find information. To open the Xilinx Documentation Navigator (DocNav):

• From the Vivado IDE, select Help > Documentation and Tutorials.
• On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.
• At the Linux command prompt, enter: docnav

Xilinx Design Hubs provide links to documentation organized by design tasks and other topics, which you can use to learn key concepts and address frequently asked questions. To access the Design Hubs:

• In the Xilinx Documentation Navigator, click the Design Hubs View tab.
• On the Xilinx website, see the Design Hubs page.
Appendix A: Additional Resources and Legal Notices

Licenses and End User License Agreements

The third-party licenses govern the use of certain third-party technology included in and/or distributed in connection with the Xilinx design tools. Each license applies only to the applicable technology expressly governed by such license and not to any other technology. You must accept the terms of the End User License Agreements (EULAs) for Xilinx design tools and third-party products before license files can be generated.

To view the third-party license details and EULA, see End User License Agreement.

To view the Xilinx design tools license details and EULA, see https://www.xilinx.com/cgi-bin/docs/rdoc?v=2016.4;d=end-user-license-agreement.pdf.

Registered Guest Resources

To view source packages which may be referenced in the Xilinx 3rd party licenses EULA, see https://www.xilinx.com/guest_resources/gnu/.

References

1. UltraFast Design Methodology Guide for the Vivado Design Suite (UG949)
2. UltraFast™ High-Level Productivity Design Methodology Guide (UG1197)
3. UltraFast Embedded Design Methodology Guide (UG1046)
13. USB Cable Installation Guide (UG344)
14. Platform Cable USB II Data Sheet ([DS593](https://www.xilinx.com))
15. Parallel Cable IV Data Sheet ([DS097](https://www.xilinx.com))
16. Xilinx Download Center
17. Xilinx Design Tools WebTalk page
18. Vivado Design Suite QuickTake Video Tutorials
19. Vivado Design Suite Documentation

## Training Resources

Xilinx provides a variety of training courses and QuickTake videos to help you learn more about the concepts presented in this document. Use these links to explore related training resources:

1. Vivado Design Suite Hands-on Introductory Workshop
2. Vivado Design Suite Tool Flow
3. Essentials of FPGA Design

## Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at [https://www.xilinx.com/legal.htm#tos](https://www.xilinx.com/legal.htm#tos); IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at [https://www.xilinx.com/legal.htm#tos](https://www.xilinx.com/legal.htm#tos).

### AUTOMOTIVE APPLICATIONS DISCLAIMER

Automotive products (identified as "XA" in the part number) are not warranted for use in the deployment of airbags or for use in applications that affect control of a vehicle ("safety application") unless there is a safety concept or redundancy feature consistent with the ISO 26262 Automotive Safety Standard ("safety design"). Customer shall, prior to using or distributing any system that incorporates products, thoroughly test such systems for safety purposes. Use of products in a safety application without a safety design is fully at the risk of customer, subject only to applicable laws and regulations governing limitations on product liability.

© Copyright 2012–2016 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.